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Safety

Safety Introduction

Notices and Safety
Please read the following instructions carefully before operating the 
machine and refer to them as needed to ensure the continued safe 
operation of your machine.

Your Xerox product and supplies have been designed and tested to meet 
strict safety requirements. These include safety agency evaluation and 
certification, and compliance with electromagnetic regulations and 
established environmental standards. 

The safety and environment testing and performance of this product have 
been verified using Xerox materials only.

WARNING: Unauthorized alterations, which may include the addition of 
new functions or connection of external devices, may impact the product 
certification. Please contact your Xerox representative for more 
information.

Marks and Labels

Symbols
All warnings and instructions marked on or supplied with the product 
should be followed.

WARNING: This symbol alerts users to areas of the equipment 
where there is the possibility of personal injury.

WARNING: This symbol alerts users to areas of the equipment 
where there are heated or hot surfaces, which should not be 
touched.

CAUTION: This symbol alerts users to areas of the equipment 
which require special attention to avoid the possibility of 
personal injury or damage to the equipment. 

WARNING: This symbol indicates a Laser is being used in the 
equipment and alerts the user to refer to the appropriate safety 
information. 

NOTE: This symbol identifies information that is being 
emphasized and is important for you to remember.

Radio Frequency Emissions

FCC Notices For The USA
NOTE: This equipment has been tested and found to comply with the 
limits for a Class B digital device, pursuant to Part 15 of the FCC Rules. 

These limits are designed to provide reasonable protection against 
harmful interference in a residential installation. This equipment 
generates, uses and can radiate radio frequency energy and, if not 
installed and used in accordance with the instructions, may cause 
harmful interference to radio communications. However, there is no 
guarantee that interference will not occur in a particular installation. If this 
equipment does cause harmful interference to radio or television 
reception, which can be determined by turning the equipment off and on, 
the user is encouraged to try to correct the interference by one or more 
of the following measures:

- Reorient or relocate the receiving antenna.

- Increase the separation between the equipment and receiver.

- Connect the equipment into an outlet on a circuit different from that to 
which the receiver is connected.

- Consult the dealer or an experienced radio/TV technician for help.

Changes or modifications to this equipment not specifically approved by 
the Xerox Corporation may void the user's authority to operate this 
equipment.

EME Compliance for Canada
This Class "B" digital apparatus complies with Canadian ICES-003.

Cet appareil numérique de la classe « B » est conforme à la norme 
NMB-003 du Canada.

 Laser Safety Introduction

Laser Safety
CAUTION: Use of controls, adjustments, or performance of 
procedures other than those specified in this guide may result in 
hazardous light exposure. 

This equipment complies with international safety standards 
and is classified as a Class 1 Laser Product.

With specific reference to lasers, the equipment complies with 
laser product performance standards set by governmental, 
national, and international agencies as a Class 1 Laser Product. 
It does not emit hazardous light, as the beam is totally enclosed 
during all phases of customer operation and maintenance.

Operational Safety Information

Operational Safety Information
Your Xerox equipment and supplies have been designed and tested to 
meet strict safety requirements. These include safety agency 
examination, approval, and compliance with established environmental 
standards.
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To ensure the continued safe operation of your Xerox equipment, follow 
these safety guidelines at all times:

Do These
• Always follow all warnings and instructions that are marked on or 

supplied with the equipment.
• Before cleaning this product, unplug the product from the electrical 

outlet. Always use materials specifically designated for this product, 
the use of other materials may result in poor performance and create a 
hazardous situation. 

• Do not use aerosol cleaners, they may be explosive and flammable 
under certain conditions.

• Always exercise care when moving or relocating equipment. Please 
contact your local Xerox Service Department to arrange relocation of 
the copier to a location outside of your building.

• Always locate the machine on a solid support surface (not on plush 
carpet) that has adequate strength to support the weight of the 
machine.

• Always locate the machine in an area that has adequate ventilation 
and room for servicing.

• Always unplug this equipment from the electrical outlet before 
cleaning.

• NOTE: Your Xerox machine is equipped with an energy saving device 
to conserve power when the machine is not in use. The machine may 
be left on continuously.

• WARNING: The metallic surfaces in the fuser area may be hot. Please 
use caution when removing paper jams from this area and avoid 
touching any metallic surfaces.

Do Not Do These
• Never use a ground adapter plug to connect the equipment to a power 

outlet that lacks a ground connection terminal.
• Never attempt any maintenance function that is not specifically 

described in this documentation.
• Never obstruct ventilation openings. They are provided to prevent 

overheating.
• Never remove covers or guards that are fastened with screws. There 

are no operator serviceable areas within these covers.
• Never locate the machine near a radiator or any other heat source.
• Never push objects of any kind into the ventilation openings.
• Never override or "cheat" any of the electrical or mechanical interlock 

devices.
• Never place this equipment where people might step on or trip on the 

power cord.
• This equipment should not be placed in a room unless proper 

ventilation is provided.  Please contact your local Authorized dealer for 
further information.

Warning - Electrical Safety Information
1 The power receptacle for the machine must meet the requirements 

stated on the data plate on the rear of the machine. If you are not 

sure that your electrical supply meets the requirements, please 
consult your local power company or an electrician for advice.

2 The socket outlet shall be installed near the equipment and shall be 
easily accessible.

3 Use the power cable that is supplied with your machine. Do not use 
an extension cord or remove or modify the power cord plug.

4 Plug the power cable directly into a correctly grounded electrical 
outlet. If you are not sure whether or not an outlet is correctly 
grounded, consult an electrician.

5 Do not use an adapter to connect any Xerox equipment to an 
electrical outlet that lacks a ground connection terminal.

6 Do not place this equipment where people might step or trip on the 
power cable.

7 Do not place objects on the power cable.

8 Do not override or disable electrical or mechanical interlock devices.

9 Do not push objects into slots or openings on the machine. Electrical 
shock or fire may result.

10 Do not obstruct ventilation openings. These openings are used to 
provide proper cooling to the Xerox machine.

11 Disconnect Device: The power cable is the disconnect device for 
this equipment. It is attached to the back of the machine as a plug-in 
device. To remove all electrical power from the machine, disconnect 
the power cable from the electrical outlet.

Electrical Supply
1 This product shall be operated from the type of electrical supply 

indicted on the product's data plate label. If you are not sure that 
your electrical supply meets the requirements, please consult your 
local power company for advice.

2  WARNING: This equipment must be connected to a protective 
earth circuit. This equipment is supplied with a plug that has a 
protective earth pin. This plug will only fit into an earthed electrical 
outlet. This is a safety feature. If you are unable to insert the plug 
into the outlet, contact your electrician to replace the outlet.

3 Always connect equipment to a correctly grounded power outlet. If 
in doubt, have the outlet checked by a qualified electrician.

Disconnect Device 
The power cable is the disconnect device for this equipment. It is 
attached to the back of the machine as a plug-in device. To remove all 
electrical power from the equipment, disconnect the power cable from the 
electrical outlet. 
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Emergency Power Off
If any of the following conditions occur, turn off the machine immediately 
and disconnect the power cable(s) from the electrical outlet(s). Contact 
an authorized Xerox Service Representative to correct the problem:

• The equipment emits unusual odors or makes unusual noises.
• The power cable is damaged or frayed.
• A wall panel circuit breaker, fuse, or other safety device has been 

tripped.
• Liquid is spilled into the machine.
• The machine is exposed to water.
• Any part of the machine is damaged.

Ozone Information
This product produces ozone during normal operation. The ozone 
produced is heavier than air and is dependent on copy volume. Install the 
system in a well-ventilated room. Providing the correct environmental 
parameters will ensure that the concentration levels meet safe limits.

If you need additional information about ozone, please request the Xerox 
publication Facts About Ozone (part number 610P64653) by calling 
1-800-828-6571 in the United States and Canada. In other markets, 
please contact your local Xerox representative.

Maintenance Information

1 Any operator product maintenance procedures will be described in 
the customer documentation supplied with the product. 

2 Do not carry out any maintenance on this product which is not 
described in the customer documentation.

3 Do not use aerosol cleaners. The use of cleaners that are not 
approved may cause poor performance of the equipment, and could 
cause a dangerous condition.

4 Use supplies and cleaning materials only as directed in this manual. 

5 Do not remove covers or guards that are fastened with screws. 
There are no parts behind these covers that you can maintain or 
service. 

6 Do not perform any maintenance procedures unless you have been 
trained to do them by an authorized local dealer or unless a 
procedure is specifically described in the user manuals.

Consumables Information
1 Store all consumables in accordance with the instructions given on 

the package or container. 

2 Keep all consumables away from the reach of children. 

3 Never throw toner, print cartridges or toner containers into an open 
flame. 

Product Safety Certification
This product is certified by the following Agency using the Safety 
standards listed; 

Regulatory Information

Certification in Europe
CE The CE mark applied to this product, symbolizes XEROX's 
declaration of conformity with the following applicable European Union 
Directives, as of the dates indicated:

December 12, 2006: Council Directive 2006/95/EC as amended. 
Approximation of the laws of the member states related to low voltage 
equipment.

December 15, 2004: Council Directive 2004/108/EC as amended. 
Approximation of the laws of the member states related to 
electromagnetic compatibility.

A full declaration of conformity, defining the relevant directives and 
referenced standards, can be obtained from your XEROX Limited 
representative or by contacting:

Environment, Heath and Safety

Xerox Limited

Bessemer Road

Welwyn Garden City

Herts

AL7 1BU

England, Telephone +44 (0) 1707 353434

WARNING: In order to allow this equipment to operate in proximity to 
Industrial, Scientific and Medical (ISM) equipment, the external radiation 
from the ISM equipment may have to be limited or special mitigation 
measures taken.

WARNING: Shielded interface cables must be used with this product to 
maintain compliance with Council Directive 2004/108/EC.

Agency Standard

Underwriters 
Laboratory Inc.

UL60950-1 1st (2003) First Edition (USA/ 
Canada)

Intertek ETL 
Semko

IEC60950-1: 2001 First Edition 
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Product Recycling & Disposal

USA & Canada
Xerox operates a worldwide equipment take back and reuse/recycle 
program. Contact your Xerox sales representative (1-800-ASK-XEROX) 
to determine whether this Xerox product is part of the program. For more 
information about Xerox environmental programs, visit
 www.xerox.com/environment.html.

If your product is not part of the Xerox program and you are managing its 
disposal, please note that the product may contain lead and other 
materials whose disposal may be regulated due to environmental 
considerations. For recycling and disposal information, contact your local 
authorities. In the United States, you may also refer to the Electronic 
Industries Alliance web site: www.eiae.org.

European Union 
WEEE Directive 2002/96/EC 

Some equipment may be used in both a domestic/household and a 
professional/business application.

 Professional/Business Environment 

Application of this symbol on your equipment is confirmation 
that you must dispose of this equipment in compliance with 
agreed national procedures. In accordance with European 
legislation, end of life electrical and electronic equipment 
subject to disposal must be managed within agreed 
procedures. 

 Domestic/Household Environment 

Application of this symbol on your equipment is confirmation 
that you should not dispose of the equipment in the normal 
household waste stream. In accordance with European 
legislation, end of life electrical and electronic equipment 
subject to disposal must be segregated from household 
waste. 

Private households within EU member states may return used 
electrical and electronic equipment to designated collection 
facilities free of charge. Please In some member states, when 
you purchase new equipment, your local retailer may be 
required to take back your old equipment free of charge. 
Please ask your retailer for information. 

Prior to disposal, please contact your local dealer or Xerox 
representative for end of life takeback information. 

EH&S Contact Information

Contact Information
For more information on Environment, Health, and Safety in relation to 
this Xerox product and supplies, please contact the following customer 
help lines:

USA:1-800 828-6571

Canada:1-800 828-6571

Europe:+44 1707 353 434

www.xerox.com/environmnet.html
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1 Introduction
Congratulations on the purchase of your printer!

This chapter includes:
• Special features
• Printer overview
• Control panel overview
• Understanding the LEDs
• Finding more information
• Setting up the hardware
• Altitude adjustment
• Changing the font setting

Special features
Your new printer is equipped with several special features that improve 
the print quality. You can:

Print with excellent quality and high speed
• You can print up to 1200 x 1200 dpi effective 

output. See the Software Section.
• Your printer prints A4-sized paper at up to 28 ppm 

and letter-sized paper at up to 30 ppm. For duplex 
printing, your printer prints A4-sized paper at up to 
14 ipm and letter-sized paper at up to 14.5 ipm.

Handle paper flexibly
• Manual tray supports one sheet of envelopes, 

labels, transparencies, custom-sized materials, 
postcards and heavy paper.

• Standard 250-sheet tray supports plain paper.
• 150-sheet output tray supports convenient access.

Create professional documents
• Print Watermarks. You can customize your 

documents with words, such as “Confidential”. See 
the Software Section.

• Print Booklets. This feature enables you to easily 
print a document to create a book. Once printed, all 
you have to do is fold and staple the pages. See 
the Software Section.

• Print Posters. The text and pictures of each page 
of your document are magnified and printed across 
the sheet of paper and can then be taped together 
to form a poster. See the Software Section.

Save time and money
• Your printer allows you to use toner save mode to 

save toner. See the Software Section.
• You can print on both sides of the paper to save 

paper. See the Software Section.
• You can print multiple pages on a single sheet of 

paper to save paper. See the Software Section.
• You can use preprinted forms and letterhead with 

plain paper. See the Software Section.
• Your printer automatically conserves electricity 

by substantially reducing power consumption when 
not in use.

Expand the printer capacity
• Your printer has 32 MB of memory which can be 

expanded to 160 MB. See page 10.1.
• You can add a 250-sheet optional tray 2 to your 

printer. This tray lets you add paper to the printer 
less often.

* Zoran IPS Emulation compatible with PostScript 3
•© Copyright 1995-2005, Zoran Corporation. 
All rights reserved. Zoran, the Zoran logo,       
IPS/PS3 and OneImage are trademarks of 
Zoran Corporation.

* 136 PS3 fonts
• Contains UFST and MicroType from Monotype Imaging Inc.

Print in various environments
•  You can print in Windows 2000/XP/2003/Vista.
•  Your printer is compatible with Linux and 

Macintosh.
•  Your printer comes with USB interfaces. 

1 2

3 4
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Machine features

The table below lists a general overview of features supported by your 
printer.
(I: Installed, O: Option, NA: Not Available)

Features Phaser 3250D Phaser 3250DN

USB 2.0
(USB 2.0: Hi-Speed USB 2.0)

I I

Network Interface
(Ethernet 10/100 Base TX)

NA I

PCL Emulation I I

PostScript Emulation I I

Duplex printinga

a. Printing on both sides of paper.

I I

Printer overview

Front view

1 output tray 6 tray 1
2 control panel 7 optional tray 2 
3 expansion memory 

cover
8 paper level indicator

4 front cover 9 output support
5 manual tray 10 manual tray paper width 

guides

10
3250-039

9

3250-040

1 2

3

4

5

6

7

8 3250-037

* The figure above shows a Phaser 3250DN.



1.3   <Introduction>

Rear view

Control panel overview

1 network porta

a. Phaser 3250DN only.

4 duplex unit
2 USB port 5 power receptacle
3 optional tray 2 cable 

connector
6 power switch

1 Error: Indicates the status of your printer. See page 9.5.

2 Online: Indicates the status of your printer. See page 9.5.

3 Start/Stop: Prints a demo page or configuration page. 
Cancels the print job. 
Resumes a print job.

1

3
2

4

5
6

3250-038

* The figure above shows a Phaser 3250DN.

1

2

3

3250-031

Understanding the LEDs

LED Status Description

Error Red On • The cover is open. Close the 
cover.

• There is no paper in the tray. 
Load paper in the tray.

• The printer has stopped printing 
due to a major error.

• The print cartridge is not 
installed. Install the print 
cartridge.

• Your system has some 
problems. If this problem 
persists, contact your service 
representative. 

• The toner is totally exhausted. 
Remove the old print cartridge 
and install a new one. See page 
8.3.

Blinking • A minor error is occurring and 
the printer is waiting for the error 
to be cleared. When the problem 
is cleared, the printer resumes 
printing. 

• The print cartridge is low. Order 
a new print cartridge. You can 
temporarily improve print quality 
by shaking the toner. See page 
8.2.

Orange On • A paper jam has occurred. To 
solve the problem, see page 9.1.

Online Green On • The printer is in power save 
mode.

• The printer is on-line and can 
receive data from the computer.

Blinking • Blinks slowly indicates that the 
printer is receiving data from the 
computer.

• Blinks quickly indicates that the 
printer is printing data.
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Finding more information
You can find information for setting up and using your printer from the 
following resources, either printed or onscreen.

Quick Install 
Guide

Provides information on setting up your 
printer, therefore, be sure to follow the 
instructions in the guide to get the printer 
ready.

Online User 
Guide

Provides you with step-by-step instructions for 
using your printer’s full features, and contains 
information for maintaining your printer, 
troubleshooting, and installing accessories.
This user guide also contains a Software 
Section providing you with information on how 
to print documents with your printer on various 
operating systems, and how to use the 
supplied software utilities.

Printer Driver 
Help

Provides you with help information on printer 
driver properties and instructions for setting up 
the properties for printing. To access a printer 
driver help screen, click Help from the printer 
properties dialog box.

Website If you have Internet access, you can get help, 
support, printer drivers, manuals, and order 
information from the Xerox website, 
www.xerox.com.

11

22 1 2 3

4 5 6

Item(s) with * mark may not be supplied depending on your model and country

quick install guide

33 1 2 3

4 5 6

44

55

66

Note
You can access the user guides in other 
languages from the Manual folder on the 
printer driver CD.

Setting up the hardware
This section shows the steps to set up the hardware which is explained 
in the Quick Install Guide. Make sure you read Quick Install Guide and 
complete following steps.

1 Select a stable location. 

Select a level, stable place with adequate space for air circulation. 
Allow extra space to open covers and trays. 

The area should be well-ventilated and away from direct sunlight or 
sources of heat, cold, and humidity. Do not set the machine close to 
the edge of your desk or table. 

Printing is suitable for altitudes under 1,000 m (3,281 ft). Refer to 
the altitude setting to optimize your printing. See page 1.5 for more 
information.

Place the machine on a flat and stable surface so there is no more 
than a 2 mm (0.08 inches) tilt. Otherwise, it may affect the printing 
quality. 

3250-041

3250-005

http://www.xerox.com
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2 Unpack the machine and check all the enclosed items.

3 Remove the tape holding the machine tightly.

4 Install the print cartridge.

5 Load paper. (See "Loading paper" on page 5.4.)

6 Make sure that all the cables are connected to the machine. 

7 Turn the machine on. 

Caution
• When you move the machine, do not tilt or turn it upside 

down. Otherwise, the inside of the machine may be 
contaminated by toner, which can cause damage to the 
machine or bad print quality.

• During installation of the print driver, your operating system is 
automatically detected and the common paper size you use is 
set. If you change operating systems, you will have to change 
the paper size through the printer properties page.

Altitude adjustment
The print quality is affected by atmospheric pressure, which is 
determined by the height of the machine above sea level. The following 
information will guide you on how to set your machine to the best print 
quality or best quality of print.

Before you set the altitude value, find the altitude where you are using 
the machine. 

1 Ensure that you have installed the printer driver with the provided     
Printer Software CD.

2 Double-click the Status Monitor icon on the Windows task bar (or 
Notification Area in Linux). 
You can also click Status Monitor on the status bar in Mac OS X.

3 Click Printer Setting.

4 Click Setting > Altitude Adjustment. Select the appropriate value 
from the dropdown list, and then click Apply. 

Note
If your machine is connected to a network, CWIS (CentreWare Internet 
Service) screen appears automatically. Click Machine Settings > 
Setup (or Machine Setup) > Altitude Adj. Select the appropriate 
altitude value, and then click Apply.

High 31

Normal4

Value

2 High 2

3 High 1
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Changing the font setting
Your machine has preset the font for your region or country. 

If you want to change the font or set the font for special conditions such 
as DOS environment, you can change the font setting as follows: 

1 Ensure that you have installed the printer driver from the provided 
software CD.

2 Double-click the Status Monitor icon on the Windows task bar (or 
Notification Area in Linux). You can also click Status Monitor on 
the status bar in Mac OS X.

3 Click Printer Setting.

4 Click Emulation.

5 Confirm if PCL is selected in Emulation Setting.

6 Click Setting.

7 Select your preferred font in the Symbol set list.

8 Click Apply.

Note
Following information shows the proper font list for corresponding 
languages.
• Russian: CP866, ISO 8859/5 Latin Cyrillic
• Hebrew: Hebrew 15Q, Hebrew-8, Hebrew-7 (Israel only)
• Greek: ISO 8859/7 Latin Greek, PC-8 Latin/Greek
• Arabic & Farsi: HP Arabic-8, Windows Arabic, Code Page 864, 

Farsi, ISO 8859/6 Latin Arabic
• OCR: OCR-A, OCR-B
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2 Basic setup
This chapter includes:
• Printing a demo page
• Using toner save mode

Printing a demo page
After setting up your printer, print a demo page to make sure that the 
printer is operating correctly.

Press and hold the Start/Stop button for about 2 seconds.

A demo page prints out.

Using toner save mode
Toner save mode allows the printer to use less toner on each page. 
Activating this mode extends the life of your print cartridge and reduces 
your cost per page beyond what one would experience in the normal 
mode, but it reduces print quality.

You can set the toner save mode from the printer properties window on 
your printer driver. See the Software Section.
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3 Software overview
This chapter gives you an overview of the software that comes with your 
printer. Further details about installing and using the software are 
explained in the Software Section.

This chapter includes:
• Supplied software
• Printer driver features
• System requirements

Supplied software
You must install the printer software using the supplied CD after you 
have set up your printer and connected it to your computer. 

The CD provides you with the following software:

CD Contents

Printer 
software 
CD

Windows • Printer driver: Use this driver to take 
full advantage of your printer’s 
features.

• Status Monitor: This program allows 
you to monitor the printer’s status and 
alerts you when an error occurs during 
printing.

• Printer Settings Utility: This program 
is automatically installed when you 
install the Status Monitor. 

• PCL6 driver: Use this driver to print 
documents in the PCL6, PCL5e 
language.

• PostScript Printer Description 
(PPD) file: Use the PostScript driver to 
print documents with complex fonts 
and graphics in the PostScript 
language.

• Set IP: Use this program to set your 
printer’s TCP/IP addresses. 

• User Guide in PDF

Linux • Printer driver: Use this driver to run 
your printer from a Linux computer 
and print documents.

• Status Monitor: This program allows 
you to monitor the printer’s status and 
alerts you when an error occurs during 
printing.

Printer driver features
Your printer drivers support the following standard features:
• Paper source selection
• Paper size, orientation and type
• Number of copies

In addition, you can use various special printing features. The following 
table shows a general overview of features supported by your printer 
drivers: 

Macintosh • Printer driver: Use this driver to run 
your printer from a Macintosh 
computer and print documents.

• Status Monitor: This program allows 
you to monitor the printer’s status and 
alerts you when an error occurs during 
printing.

Feature
PCL 6 PostScript

Windows Windows Macintosh Linux

Toner save O O O O

Print quality 
option

O O O O

Poster 
printing

O X X X

Multiple 
pages per 
sheet (N-up)

O O O O       
(2, 4)

Fit to page 
printing

O O O O

Scale printing O O O O

Watermark O X X X

Overlay O X X X

CD Contents
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System requirements
Before you begin, ensure that your system meets the following 
requirements:

Windows

Item Requirements Recommended

Operating 
system

Windows 2000/XP/2003/Vista

CPU Windows 2000 Pentium II 
400 MHz or 
higher

Pentium III 
933 MHz

Windows XP/
2003/Vista

Pentium III 
933 MHz or 
higher

Pentium IV 
1 GHz

RAM Windows 2000 64 MB or more 128 MB

Windows XP/
2003 128 MB or more 256 MB

Windows Vista 512 MB or more 1 GB

Free disk 
space

Windows 2000 600 MB or more 1 GB

Windows XP/
2003

1 GB or more 5 GB

Windows Vista 15 GB 15 GB or more

Internet 
Explorer

Windows 2000/
XP/2003

5.0 or higher

Windows Vista 7.0 or higher

Note
• For Windows 2000/XP/2003/Vista, users who have an 

administrator right can install the software. 

Linux

Macintosh

Item Requirements

Operating system Various Linux OS including
• Red Hat 8~9
• Fedora Core 1~4
• Mandrake 9.2~10.1
• SuSE 8.2~9.2

Processor Pentium IV 1 GHz or higher

RAM 256 MB or higher

Free disk page 1 GB or higher

Software • Linux Kernel 2.4 or higher
• Glibc 2.2 or higher
• CUPS

Operating 
system

Requirement (Recommended)

CUP RAM Free HDD 
space

Mac OS X 10.4 
or lower

• PowerPC 
G4/G5

• Intel 
processors

• 128 MB for a 
PowerPC based 
MAC (512 MB)

• 512 MB for an 
Intel based 
MAC (1 GB)

1 GB

Mac OS X 10.5 • 867 MHz or 
faster 
PowerPC 
G4/G5

• Intel 
processors

512 MB (1 GB) 1 GB
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4 Network setup (Phaser 3250DN 
only)

This chapter gives you basic information for setting up your printer for 
network connections.

This chapter includes:
• Introduction
• Supported operating systems
• Using SetIP program

Introduction
Once you have connected your printer to a network with an RJ-45 
Ethernet cable, you can share the printer with other network users.

Switch the printer on.

You need to set up the network protocols on the printer to use it as your 
network printer. Protocols can be set up by the following programs:
• CWIS (CentreWare Internet Service): A web-based printer 

management solution for network administrators. CWIS (CentreWare 
Internet Service) provides you with an efficient way of managing 
network devices and lets you remotely monitor and troubleshoot 
network printers from any site with corporate intranet access. You can 
download this program from www.xerox.com.

• CWIS (CentreWare Internet Service): A web server embedded to 
your network print server, which allows you to configure the network 
parameters necessary for the printer to connect to various network 
environments.

• SetIP: A utility program allowing you to select a network interface and 
manually configure the addresses for use with the TCP/IP protocol. 
This program is on the software CD that comes with your printer.

Supported operating systems
The following table shows the network environments supported by the 
printer: 

Note
Holding the button down for 7~8 seconds (green light will blink 
fast) then releasing it, will print a configuration page with the IP 
address.

Item Requirements

Network interface • 10/100 Base-TX

• TCP/IP: Transmission Control Protocol/Internet Protocol
• DHCP: Dynamic Host Configuration Protocol
• BOOTP: Bootstrap Protocol

Using SetIP program 
This program is for the network IP setting using the MAC address which 
is the hardware serial number of the network printer card or interface. 
Especially, it is for the network administrator to set several network IPs 
at the same time. 

1 Insert the driver CD provided along with your machine. 

2 Open the X drive. (X represents your CD-ROM drive.)

3 Double click Application > SetIP 

4 Open the language folder you want to use.

5 Double click Setup.exe to install this program. 

6 From the Windows Start menu, select Programs > Xerox Phaser 
3250 > SetIP > SetIP.

7 Select the name of your printer and click “  ”. 

Network operating 
system

• Windows 2000/XP (32/64 bit)/2003/Vista
• Various Linux OS including Red Hat 8~9, 

Fedora Core 1~4, Mandrake 9.2~10.1, 
SuSE 8.2~9.2

• Mac OS 10.3~10.5

Network protocols • TCP/IP
• EtherTalk
• HTTP 1.1
• SNMP

Dynamic 
addressing server

• DHCP, BOOTP

Note
If you want to setup DHCP network protocol, go to the http://
developer.apple.com/networking/bonjour/download/, select 
the program Bonjour for Windows due to your computer 
operating system, and install the program. This program will 
allow you to fix the network parameter automatically. Follow 
the instruction in the installation window. This program does 
not support Linux.

Note
If you cannot find your printer name click “  ” to refresh the 
list.

Item Requirements

http://www.xerox.com
http://developer.apple.com/networking/bonjour/download/
http://developer.apple.com/networking/bonjour/download/
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8 Enter the network card’s MAC address, IP address, subnet mask, 
default gateway, and then click Apply.

9 Click OK to confirm the settings.

10 Click Exit to close the SetIP program.

Note
If you do not know the network card’s MAC address, print the 
machine’s network information report. 
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5 Loading print media
This chapter will help you understand the types of paper you can use 
with your printer and how to properly load paper in the different paper 
trays for the best print quality. 

This chapter includes:
• Selecting print media
• Loading paper
• Output tray information

Selecting print media
You can print on a variety of print media, such as plain paper, envelopes, 
labels, and transparencies. Always use print media that meet the 
guidelines for use with your printer. Print media that does not meet the 
guidelines outlined in this user guide may cause the following problems:
• Poor print quality
• Increased paper jams
• Premature wear of the output tray components

Properties, such as weight, composition, grain, and moisture content, 
are important factors that affect the machine’s performance and the 
output quality. When you choose print materials, consider the following:
• The type, size and weight of the print media for your machine are 

described later in this section.
• Desired outcome: The print media you choose should be appropriate 

for your project.
• Brightness: Some print media are whiter than others and produce 

sharper, more vibrant images.
• Surface smoothness: The smoothness of the print media affects how 

crisp the printing looks on the paper.

Notes
• Some print media may meet all of the guidelines in this section 

and still not produce satisfactory results. This may be the 
result of improper handling, unacceptable temperature and 
humidity levels, or other variables over which Xerox has no 
control.

• Before purchasing large quantities of print media, ensure that 
it meets the requirements specified in this user guide. 

Caution
• Using print media that does not meet these specifications may 

cause problems, requiring repairs. Such repairs are not 
covered by Xerox’s warranty or service agreements.
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Supported sizes of paper

Type Size Dimensions Weighta

a. If media weight is over 24 lb (90 g/m2), use the manual feed.

Capacityb

b. Maximum capacity may differ depending on media weight, thickness, and environmental conditions.

Plain paper

Letter 216 x 279 mm (8.5 x 11 inches) • 60 to 105 g/m2 (16 to 28 lb 
bond) for the tray

• 60 to 163 g/m2 (16 to 43 lb 
bond) for the manual feed

• 250 sheets of 75 g/m2 
(20 lb bond) paper for the 
tray

• 1 sheet for manual feeding

Legal 216 x 356 mm (8.5 x 14 inches)

Folio 216 x 330.2 mm (8.5 x 13 inches)

Oficio 216 x 343 mm (8.5 x 13.5 inches)

A4 210 x 297 mm (8.26 x 11.69 inches)

JIS B5 182 x 257 mm (7.18 x 10.12 inches)

ISO B5 176 x 250 mm (6.93 x 9.84 inches)

Executive 184 x 267 mm (7.25 x 10.5 inches)

A5 148 x 210 mm (5.82 x 8.26 inches)

A6 105 x 148 mm (4.13 x 5.82 inches)

Envelope

Envelope B5 176 x 250 mm (6.93 x 9.84 inches)

75 to 90 g/m2 (20 to 24 lb) 1 sheet for manual feeding

Envelope Monarch 98.4 x 190.5 mm (3.88 x 7.5 inches)

Envelope COM-10 105 x 241 mm (4.12 x 9.5 inches)

Envelope DL 110 x 220 mm (4.33 x 8.66 inches)

Envelope C5 162 x 229 mm (6.38 x 9.02 inches)

Envelope C6 114 x 162 mm (4.49 x 6.38 inches)

Transparency Letter, A4 Refer to the Plain paper section 138 to 146 g/m2 (37 to 39 lb) 1 sheet for manual feeding

Labels

Letter, Legal, Folio, 
Oficio, A4, JIS B5, 
ISO B5, Executive, 
A5, A6

Refer to the Plain paper section 120 to 150 g/m2 (32 to 40 lb) 1 sheet for manual feeding

Card stock

Letter, Legal, Folio, 
Oficio, A4, JIS B5, 
ISO B5, Executive, 
A5, A6

Refer to the Plain paper section 60 to 163 g/m2 (16 to 43 lb) 1 sheet for manual feeding

Minimum size (custom) 76 x 127 mm (3.86 x 5.83 inches) 60 to 163 g/m2

(16 to 43 lb bond) 1 sheet for manual feeding
Maximum size (custom) 215.9 x 356 mm (8.5 x 14 inches)
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Media sizes supported in each mode

Guidelines for selecting and storing print media
When selecting or loading paper, envelopes, or other print media, keep 
these guidelines in mind:
• Always use print media that conform with the specifications listed on 

the next column.
• Attempting to print on damp, curled, wrinkled, or torn paper can cause 

paper jams and poor print quality.
• For the best print quality, use only high quality copier grade paper 

specifically recommended for use in laser printers.
• Avoid using the following print media types:

- Paper with embossed lettering, perforations, or a texture that is too 
smooth or too rough

- Erasable bond paper
- Multi-paged paper
- Synthetic paper and thermally reactive paper
- Carbonless paper and Tracing paper. 

• Use of these types of paper could result in paper jams, chemical 
smells, and damage to your printer.

• Store print media in its ream wrapper until you are ready to use it. 
Place cartons on pallets or shelves, not on the floor. Do not place 
heavy objects on top of the paper, whether it is packaged or 
unpackaged. Keep it away from moisture or other conditions that can 
cause it to wrinkle or curl.

• Store unused print media at temperatures between 15 and 30oC (59 
to 86oF). The relative humidity should be between 10 and 70%.

• Store unused print media in a moisture-proof wrap, such as a plastic 
container or bag, to prevent dust and moisture from contaminating 
your paper.

• Load special print media types one sheet at a time through the 
manual tray to avoid paper jams.

• To prevent print media, such as transparencies and label sheets, from 
sticking together, remove them as they print out.

Mode Size Source

Single side 
printing

All sizes supported by 
the machine

• tray 1
• manual feed

Duplex printinga

a. 75 to 90 g/m2 (20 to 24 lb) only.

Letter, A4, Legal, Folio, 
Oficio

• tray 1
• manual feed

Caution
• If you print 20 envelopes in succession, the surface of the top 

cover may become hot. Please exercise caution.

Guidelines for special print media

Type Guidelines

Envelopes • Successful printing on envelopes depends 
upon the quality of the envelopes. When 
selecting envelopes, consider the following 
factors:
- Weight: The weight of the envelope paper 

should not exceed 90 g/m2 (24 lb) or jamming 
may occur.

- Construction: Prior to printing, envelopes 
should lie flat with less than 6 mm 
(0.25 inches) curl, and should not contain air.

- Condition: Envelopes should not be wrinkled, 
nicked, or otherwise damaged.

- Temperature: You should use envelopes that 
are compatible with the heat and pressure of 
the printer during operation.

• Use only well-constructed envelopes with sharp 
and well creased folds.

• Do not use stamped envelopes.
• Do not use envelopes with clasps, snaps, 

windows, coated lining, self-adhesive seals, or 
other synthetic materials.

• Do not use damaged or poorly made 
envelopes.

• Be sure the seam at both ends of the envelope 
extends all the way to the corner of the 
envelope.

• Envelopes with a peel-off adhesive strip or with 
more than one flap that folds over to seal must 
use adhesives compatible with the printer’s 
fusing temperature for 0.1 second. Check your 
machine’s specification to view the fusing 
temperature, see page 11.1. The extra flaps 
and strips might cause wrinkling, creasing, or 
jams, and may even damage the fuser.

• For the best print quality, position margins no 
closer than 15 mm (0.6 inches) from the edges 
of the envelope.

• Avoid printing over the area where the 
envelope’s seams meet.

Acceptable

Unacceptable
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Transparencies • To avoid damaging the printer, use only 
transparencies designed for use in laser 
printers.

• Transparencies used in the printer must be able 
to withstand the machine’s fusing temperature. 
Check your machine’s specification to view the 
fusing temperature, see page 11.1.

• Place them on a flat surface after removing 
them from the printer.

• Do not leave them in the paper tray for long 
periods of time. Dust and dirt may accumulate 
on them, resulting in spotty printing.

• To avoid smudging caused by fingerprints, 
handle them carefully.

• To avoid fading, do not expose printed 
transparencies to prolonged sunlight.

• Ensure that transparencies are not wrinkled, 
curled, or have any torn edges.

Labels • To avoid damaging the printer, use only labels 
designed for use in laser printers.

• When selecting labels, consider the following 
factors:
- Adhesives: The adhesive material should be 

stable at 180° C (356° F), the printer’s fusing 
temperature.

- Arrangement: Only use labels with no 
exposed backing between them. Labels can 
peel off sheets that have spaces between the 
labels, causing serious jams.

- Curl: Prior to printing, labels must lie flat with 
no more than 13 mm (5 inches) of curl in any 
direction.

- Condition: Do not use labels with wrinkles, 
bubbles, or other indications of separation.

• Make sure that there is no exposed adhesive 
material between labels. Exposed areas can 
cause labels to peel off during printing, which 
can cause paper jams. Exposed adhesive can 
also cause damage to printer components.

• Do not run a sheet of labels through the printer 
more than once. The adhesive backing is 
designed for only a single pass through the 
printer.

• Do not use labels that are separating from the 
backing sheet or are wrinkled, bubbled, or 
otherwise damaged.

Card stock or 
custom-sized 
materials

• Do not print on print media smaller than 76 mm 
(3 inches) wide or 127 mm (5 inches) long.

• In the software application, set margins at least 
6.4 mm (0.25 inches) away from the edges of 
the material.

Type Guidelines

Loading paper
Load the print media you use for the majority of your print jobs in the tray 
1. The tray 1 can hold a maximum of 250 sheets of 20 lb plain paper. 

You can purchase an optional tray (tray 2) and attach it below the 
standard tray to load an additional 250 sheets of paper. For order 
information for an optional tray, see 7.1.

The paper level indicator on the front of the tray 1 and the optional tray 
2 shows the amount of paper currently left in the tray. When the tray is 
empty, the indicator bar is completely lowered.

Preprinted 
paper

• Letterhead must be printed with heat-resistant 
ink that will not melt, vaporize, or release 
hazardous emissions when subjected to the 
printer’s fusing temperature for 0.1 second. 
Check your machine’s specification to view the 
fusing temperature, see page 11.1.

• Letterhead ink must be non-flammable and 
should not adversely affect printer rollers.

• Forms and letterhead should be sealed in a 
moisture-proof wrapping to prevent changes 
during storage.

• Before you load preprinted paper, such as 
forms and letterhead, verify that the ink on the 
paper is dry. During the fusing process, wet ink 
can come off preprinted paper, reducing print 
quality.

Type Guidelines

3250-033

Full ▲ ▲ Empty
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Using tray 1 or the optional tray 2
Use the print material you use for the majority of your print jobs in tray 1. 
Tray 1 can hold a maximum of 250 sheets of 75 g/m2 paper.

You can purchase an optional tray 2 and attach it below tray 1 to load an 
additional 250 sheets of paper.

To load paper, pull open the tray and load paper with the side to be 
printed on face down.

You can load letterhead paper with the design side face down. The top 
edge of the sheet with the logo should be placed at the front of the tray.

Notes
• If you experience problems with paper feed, place one sheet 

at a time in the manual feed.
• You can load previously printed paper. The printed side 

should be facing up with an uncurled edge at the front. If you 
experience problems with paper feed, turn the paper around. 
Note that the print quality is not guaranteed.

Changing the size of the paper in tray 1
To load longer sizes of paper, such as Legal-sized paper, you need to 
adjust the paper guides to extend the paper tray.

3250-030

3250-042

3 1
2

4

1 paper length guide
2 support guide
3 guide lock
4 paper width guides

1 Press and hold the guide lock, and slide the paper length guide to 
locate it in the correct paper size slot.

2 After inserting paper into the tray, adjust the support guide so that it 
lightly touches the paper stack.

3 Squeeze the paper width guides, as shown and slide them to the 
stack of paper until they lightly touch the side of the stack.

3250-027

3250-028

3250-029
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Notes
• Do not push the paper width guide far enough to cause the 

material to warp. 
• If you do not adjust the paper width guide, it may cause paper 

jams.

Using the manual feeder
You can manually load a sheet of print media in the manual tray if you 
select Manual Feeder in the Source option from the Paper tab when you 
change print settings to print a document. See the Software Section. 
Manually loading paper can be helpful when you want to check the print 
quality after each page is printed. 

Load paper sheet-by-sheet in the manual tray, send print data to print the 
first page, and press the Start/Stop button on the control panel to print 
each following page.

1 Open the manual feed door.

2 Load the paper with the side to be printed on facing up. 

3250-024

3250-025

3 Adjust the manual tray paper width guides to the width of the paper. 
Do not force too much, or the paper will bend, which could result in 
a paper jam or skew.

4 When you print a document, set the paper source to Manual 
Feeder and select the appropriate paper size and type in the 
software application. See the Software Section. 

5 Print a document.

6 Press the Start/Stop button.

The printer feeds the next sheet.

7 Insert the next sheet into the manual tray and press the Start/Stop 
button. 

Repeat this step for every page to be printed.

Note
• If you do not press the Start/Stop button, after a pause the 

printer will automatically feed the print media.

3250-026
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 Output tray information
 

The output tray collects paper face down, in the order in which the sheets 
were printed. 

Notes
• If you continuously print many pages, the surface of the output 

tray may become hot. Be careful not to touch the surface, and 
especially keep children away from the surface.

• The output tray can hold up to 150 sheets of 75 g/m2 (20 lb) 
plain paper. Remove the pages so that the tray is not 
overloaded.

3250-043

1

1 output tray
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6 Basic printing
This chapter explains common printing tasks. 

This chapter includes:
• Printing a document
• Canceling a print job

Printing a document
This printer allows you to print from various Windows, Macintosh, or 
Linux applications. The exact steps for printing a document may vary 
depending on the application you use. 

For details about printing, see the Software Section.

Canceling a print job
If the print job is waiting in a print queue or print spooler, such as the 
printer group in Windows, delete the job as follows:

1 Click the Windows Start button.

2 For Windows 2000, select Settings and then Printers.

For Windows XP (32/64 bit)/2003, select Printers and Faxes.

For Windows Vista, select Control Panel > Hardware and Sound  
> Printers.

3 Double-click the Xerox Phaser 3250 icon.

4 From the Document menu, select Cancel.

You can also cancel the current job by pressing the Start/Stop button on 
the control panel of your printer.

Note
• You can access this window simply by double-clicking the 

printer icon at the bottom right corner of the Windows desktop.
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7 Ordering supplies and 
accessories

This chapter provides information on the print cartridge and accessories 
that are available for your printer.

This chapter includes:
• Print cartridge
• Accessories
• How to purchase

Print cartridge
When the toner runs out, you can order the following type of toner 
cartridge for your printer:

Type Yielda

a. Declared yield value in accordance with ISO/IEC 19752.

Part number

Standard yield Approx. 3,500 pages 106R01373

High yield Approx. 5,000 pages 106R01374

Caution
Are you sure you want to gamble on your printing equipment? 
Use Xerox original supplies to ensure optimal image quality and 
device endurance.

Accessories
You can purchase and install the following accessory to your Phaser 
3250D and Phaser 3250DN printer:

How to purchase
To order Xerox-authorized supplies or accessories, contact your local 
Xerox dealer or the retailer where you purchased your printer, or visit 
www.xerox.com and select your country/region for information on calling 
for technical support.

Accessory Description Part number

Optional Tray If you are 
experiencing frequent 
paper supply 
problems, you can 
attach up to three 
additional 250 sheet 
tray. You can print 
documents on various 
sizes and types of 
print media.

098N02194

Memory 
DIMM

Extends your printer’s 
memory capacity.

098N02195

http://www.xerox.com
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8 Maintenance
This chapter provides information for maintaining your printer and the 
print cartridge.

This chapter includes:
• Cleaning the printer
• Maintaining the print cartridge
• Printing a configuration page
• Maintenance parts

Cleaning the printer
During the printing process, paper, toner, and dust particles can 
accumulate inside the printer. This buildup can cause print quality 
problems, such as toner specks or smearing. 

Cleaning the outside of the printer
Clean the cabinet of the printer with a soft, lint-free cloth. You can 
dampen the cloth slightly with cold water, but be careful not to let any 
water drip onto or into the printer.

Caution
• Always use materials specifically designated for the product. 

The use of other materials may result in damage or poor 
performance, and create a hazardous situation.

• Do not use aerosol cleaners. They may be explosive and 
flammable under certain conditions.

• If your machine or its cover is contaminated with toner, we 
recommend you use a cloth or tissue dampened with cold 
water to clean it. Do not use a vacuum cleaner for toner spills.

Cleaning the inside of the printer
1 Turn the printer off and unplug the power cord. Wait for the printer 

to cool down.

2 Open the front cover and pull the print cartridge out. Set it on a 
clean flat surface.

3 With a dry lint-free cloth, wipe away any dust and spilled toner from 
the print cartridge area and the print cartridge cavity.

Caution
• To prevent damage to the print cartridge, do not expose it to 

light for more than a few minutes. Cover it with a piece of 
paper, if necessary. 

• Do not touch the green surface underside of the print cartridge. 
Use the handle on the cartridge to avoid touching this area.

Caution
• While cleaning the inside of the printer, be careful not to reach 

too far into the printer. The fuser area may be hot.

3250-001

3250-002
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4 Gently swab the long strip of glass (LSU) inside the top of the 
cartridge and check for dirt or dust.

5 Hold the print cartridge by the handle and slowly insert the cartridge 
into the opening in the printer. 

Tabs on the sides of the cartridge and corresponding grooves 
within the printer will guide the cartridge into the correct position 
until it locks into place completely.

6 Close the front cover. Make sure that the cover is securely closed.

7 Plug in the power cord and turn the printer on.

Note
• The long strip of glass is hard to locate.

3250-003

3250-004

Maintaining the print cartridge

Print cartridge storage
To get the most from the print cartridge, keep the following guidelines in 
mind:
• Do not remove the print cartridge from its package until ready for use.
• Do not refill the print cartridge. The printer warranty does not 

cover damage caused by using a refilled cartridge.
• Store print cartridge in the same environment as the printer.
• To prevent damage to the print cartridge, do not expose it to light for 

more than a few minutes.

Expected cartridge life
The life of the print cartridge depends on the amount of toner that print 
jobs require. The actual number may also be different depending on the 
print density of the pages you print on, and the number of pages may be 
affected by operating environment, printing interval, media type, and 
media size. If you print a lot of graphics, you may need to change the 
cartridge more often.

Redistributing toner in the print cartridge
When the print cartridge is near the end of its life span:
• White streaks and light printing occur.
• The Status Monitor program window appears on the computer.
• The Error LED blinks red.

If this happens, you can temporarily reestablish print quality by 
redistributing the remaining toner in the cartridge. In some cases, white 
streaks or light printing will still occur even after you have redistributed 
the toner.

1 Open the front cover.

2 Pull the print cartridge out.

3250-001
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3 Thoroughly shake the cartridge 5 or 6 times to distribute the toner 
evenly inside the cartridge. 

4 Hold the print cartridge by the handle and slowly insert the cartridge 
into the opening in the printer. 

Tabs on the sides of the cartridge and corresponding grooves 
within the printer will guide the cartridge into the correct position 
until it locks into place completely.

5 Close the front cover. Make sure that the cover is securely closed.

Caution
• Avoid reaching too far into the printer. The fuser area may be 

hot.
• To prevent damage to the print cartridge, do not expose it to 

light for more than a few minutes. Cover it with a piece of 
paper, if necessary. 

• Do not touch the green surface underside of the print 
cartridge. Use the handle on the cartridge to avoid touching 
this area.

Caution
• If toner gets on your clothing, wipe it off with a dry cloth and 

wash clothing in cold water. Hot water sets toner into fabric.

Note
• After these steps, if the problem persists, replace the print 

cartridge. See next section.

3250-034

3250-004

Replacing the print cartridge
When the toner is completely empty or the print cartridge reached the 
end of its life span:
• The printer stops printing.
• The Status Monitor program window appears on the computer.
• The Error LED blinks red.

At this stage, the print cartridge needs to be replaced. For print cartridge 
ordering information, see page 7.1.

1 Open the front cover.

2 Pull the old print cartridge out.

3 Remove the new print cartridge from its bag.

Caution
• Do not use sharp objects, such as a knife or scissors, to open 

the print cartridge package. They might scratch the drum of the 
cartridge.

3250-001
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4 Thoroughly shake the cartridge 5 or 6 times to distribute the toner 
evenly inside the cartridge. Doing so will help ensure maximum 
copies per cartridge. 

5 Remove the paper protecting the print cartridge by pulling the 
packing tape.

6 Hold the print cartridge by the handle and slowly insert the cartridge 
into the opening in the printer.

Note
• Refer to the helpful pictures on the cartridge wrapping paper.

Caution
• If toner gets on your clothing, wipe it off with a dry cloth and 

wash clothing in cold water. Hot water sets toner into fabric.
• To prevent damage to the print cartridge, do not expose it to 

light for more than a few minutes. Cover it with a piece of 
paper, if necessary. 

• Do not touch the green surface underside of the print cartridge. 
Use the handle on the cartridge to avoid touching this area.

3250-034
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Tabs on the sides of the cartridge and corresponding grooves 
within the printer will guide the cartridge into the correct position 
until it locks into place completely.

7 Close the front cover. Make sure that the cover is securely closed.

Printing a configuration page
You can print a configuration page to view current printer settings, or to 
help troubleshoot printer problems.

Press and hold the Start/Stop button for about 5 seconds.

A configuration page prints out.

Maintenance parts
To avoid print quality and paper feed problems resulting from worn parts 
and to maintain your machine in top working condition the following 
items will need to be replaced at the specified number of pages or when 
the life span of each item has expired.

Xerox highly recommends that an authorized service provider, dealer or the 
retailer where you bought printer performs this maintenance activity. The 
warranty does not cover the replacement of the maintenance parts after their 
lifespan.

Items Yield (Average)

Transfer roller Approx. 50,000 pages

Fuser unit Approx. 50,000 pages

Pick-up roller Approx. 50,000 pages

3250-004
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9 Troubleshooting
This chapter provides helpful information for what to do if you encounter 
an error while using your printer. 

This chapter includes:
• Clearing paper jams
• Troubleshooting checklist
• Solving general printing problems
• Solving print quality problems
• Common Windows problems
• Common PostScript problems
• Common Linux problems
• Common Macintosh problems

Clearing paper jams

When a paper jam occurs, the Error LED lights orange. Open and close 
the front cover. The jammed paper automatically exits the printer. 

In paper feed area

In the tray 1

1 Pull tray 1 open.

Note
• When removing paper that is jammed in the printer, if possible 

always pull the paper in the direction that it normally moves so 
as not to damage internal components. Always pull firmly and 
evenly; do not jerk the paper. If the paper tears, ensure that all 
fragments of paper are removed; otherwise a jam will occur 
again.

3250-019

2 Remove the jammed paper by gently pulling it straight out. Make 
sure that all of the paper is properly aligned in the tray 1.

If the paper does not move when you pull, or if you do not see the 
paper in this area, check the fuser area around the print cartridge. 
See page 9.2.

3 Insert the tray 1 into the printer until it snaps into place. Printing 
automatically resumes.

In the optional tray 2

1 Pull the optional tray 2 open.

2 Remove the jammed paper from the printer.

If the paper does not move when you pull, or if you do not see the 
paper in this area, stop and go to step 3.

3 Pull tray 1 half way.

3250-020
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4 Pull the paper straight up and out.

5 Insert the trays back into the printer. Printing automatically 
resumes.

In the manual tray

1 Remove the jammed paper from the printer.

2 Open and close the front cover.

3 Load media into the manual feeder, then the printer resumes.

3250-022

3250-015

Areas near the print cartridge
Caution
The fuser area is hot. Take care when removing paper from the 
printer.

1 Open the front cover and pull the print cartridge out.

2 Remove the jammed paper by gently pulling it straight out.

3 Replace the print cartridge and close the front cover. Printing 
automatically resumes.

3250-013
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In the paper exit area
1 Open and close the front cover. The jammed paper is automatically 

ejected from the printer. 

2 Gently pull the paper out of the output tray.

If you do not see the jammed paper or if there is any resistance 
when you pull, stop and go to the next step.

3 Open the rear cover.

4 Lower the rear guide assembly and remove the paper. Return the 
rear guide assembly to its original position.

5 Close the rear cover. Printing automatically resumes.

3250-016

3250-018

1

1 guide rear

In the duplex unit area
If the duplex unit is not inserted correctly, paper jam may occur. Make 
sure that the duplex unit is inserted correctly.

Duplex jam 0

1 Pull the duplex unit out of the printer.

2 Remove the jammed paper from the duplex unit.

If the paper does not come out with the duplex unit, remove the 
paper from the bottom of the printer.

3250-010

1

1 duplex unit
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Duplex jam 1

1 Open the rear cover.

2 Lower the rear guide and remove the paper. Return the rear guide 
to its original position.

3 Close the rear cover. Printing automatically resumes.

Tips for avoiding paper jams
By selecting the correct media types, most paper jams can be avoided. 
When a paper jam occurs, follow the steps outlined on 9.1. 
•  Follow the procedures on 5.5. Ensure that the adjustable guides are 

positioned correctly.
•  Do not overload the tray. Ensure that the paper level is below the 

paper capacity mark on the inside wall of the tray.
•  Do not remove paper from the tray while your printer is printing.
•  Flex, fan, and straighten paper before loading. 
•  Do not use creased, damp, or highly curled paper.
•  Do not mix paper types in a tray.
•  Use only recommended print media. See 5.1.
•  Ensure that the recommended print side of print media is facing down 

in the tray, or facing up in the manual tray.

If paper jams occur frequently when you print on A5-sized paper:

3250-018

1

1 guide rear

Load the paper into the tray with the long edge facing the front of the 
tray. 

In the printer properties window, set the page orientation to be rotated 
90 degrees. See the Software Section.

3250-023
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Troubleshooting checklist
If the printer is not working properly, consult the following checklist. If the 
printer does not pass a step, follow the corresponding suggested 
solutions.

Condition Suggested solutions

Make sure that the 
Online LED on the 
control panel lights 
green.

• If the Online LED is off, check the power 
cord connection. Check the power switch. 
Check the power source by plugging the 
power cord into another outlet.

Print a demo page 
to verify that the 
printer is feeding 
paper correctly. See 
page 2.1.

• If a demo page does not print, check the 
paper supply in the tray.

• If the paper jams in the printer, see page 
9.1.

Check the demo 
page to see if it 
printed correctly.

If there is a print quality problem, see page 
9.7.

Print a short 
document from a 
software application 
to verify that the 
computer and 
printer are 
connected and are 
communicating 
correctly.

• If the page does not print, check the cable 
connection between the printer and the 
computer. If you have a network printer 
check the cable connecting the printer to 
the network.

• Check the print queue or print spooler to 
see if the printer has been paused.

• Check the software application to ensure 
that you are using the proper printer driver 
and communication port. If the page is 
interrupted during printing, see page 9.5.

If completing the 
checklist does not 
resolve the printer 
problem, check the 
following 
troubleshooting 
sections.

• “Understanding the LEDs” on page 1.3.
• “Solving general printing problems” on 

page 9.5.
• “Common Windows problems” on page 

9.9.
• “Common PostScript problems” on page 

9.10.
• “Common Linux problems” on page 9.10.
• “Common Macintosh problems” on page 

9.11.

Solving general printing problems
For problems with the operation of your printer, refer to the table for 
suggested solutions.

Condition Possible cause Suggested solutions

The printer 
does not 
print.

The printer is not 
receiving power.

Check the power cord 
connections. Check the power 
switch and the power source.

The printer is not 
selected as the 
default printer.

Select Xerox Phaser 3250 or 
Xerox Phaser 3250 PS as 
your default printer.

The printer cover 
is not closed.

Close the printer cover.

Paper is jammed. Clear the paper jam. See page 
9.1.

No paper is 
loaded.

Load paper. See page 5.4.

The print 
cartridge is not 
installed.

Install the print cartridge.

The printer may 
be in manual feed 
mode and out of 
paper.

Add paper to the manual tray, 
and press the Start/Stop 
button on the control panel.

The connection 
cable between 
the computer and 
the printer is not 
connected 
properly.

Disconnect the printer cable (or 
network cable) and reconnect 
it.

The connection 
cable between 
the computer and 
the printer is 
defective.

If possible, attach the cable to 
another computer that is 
working properly and try to print 
a document. You can also try 
using a different printer cable 
(or network cable).

The port setting is 
incorrect.

Check the Windows printer 
setting to make sure that the 
print job is sent to the correct 
port. If the computer has more 
than one port, make sure that 
the printer is attached to the 
correct one.
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The printer 
does not 
print.
(Continued)

The printer may 
be configured 
incorrectly. 

Check the printer properties to 
ensure that all of the print 
settings are correct. 

The printer driver 
may be 
incorrectly 
installed.

Reinstall the printer driver; See 
the Software Section. Try 
printing a test page.

The printer is 
malfunctioning.

Check the LEDs on the control 
panel to determine if the printer 
is indicating a system error.

Printer 
selects print 
media from 
the wrong 
paper 
source.

The paper source 
selection in the 
printer properties 
may be incorrect.

For many software 
applications, the paper source 
selection is found under the 
Paper tab within the printer 
properties. Select the correct 
paper source. See the 
Software Section.

Paper does 
not feed into 
the printer.

Paper has not 
been loaded 
correctly.

Remove paper from the tray 
and reload it correctly.
Check that the adjustable 
guides are set correctly.

There is too much 
paper in the tray.

Remove excess paper from the 
tray.

The paper is too 
thick.

Use only paper that meets 
printer specifications.

Print job is 
extremely 
slow.

The job may be 
very complex.

Reduce the complexity of the 
page(s) or try adjusting the 
print quality settings.
To adjust the print quality 
settings, reduce the resolution. 
If you have set the resolution to 
1200 dpi (Best), change it to 
600 dpi (Normal). See the 
Software Section.
Change the port setting to the 
USB or network port to improve 
print speed.
Your printer prints A4-sized 
paper at 28 ppm and letter-
sized paper at 30 ppm.

The computer 
may have 
insufficient 
random-access 
memory (RAM). 

Simplify the page layout and 
remove any unnecessary 
graphics from the document. 
Consider buying a 128 MB 
memory option.

Condition Possible cause Suggested solutions

Half the page 
is blank.

The page layout 
is too complex.

Simplify the page layout and 
remove any unnecessary 
graphics from the document.

The page 
orientation setting 
may be incorrect.

Change the page orientation in 
your application. See the 
Software Section.

The paper size 
and the paper 
size settings do 
not match.

Ensure that the paper size in 
the printer driver settings 
matches the paper in the tray.
Or, ensure that the paper size 
in the printer driver settings 
matches the paper selection in 
the software application 
settings you use.

The paper 
keeps 
jamming.

There is too much 
paper in the tray.

Remove excess paper from the 
tray. 
If printing on special print 
media, use the manual tray.

An incorrect type 
of paper is being 
used.

Use only paper that meets 
printer specifications.
If printing on special print 
media, use the manual tray.

There may be 
debris inside the 
printer.

Open the front cover and 
remove the debris or left over 
pieces of paper.

The printer 
prints, but 
the text is 
wrong, 
garbled, or 
incomplete.

The printer cable 
is loose or 
defective.

Disconnect and reconnect the 
printer cable. Try a print job that 
you have already printed 
successfully. If possible, attach 
the cable and printer to another 
computer and try a print job 
that you know works. Finally, 
try a new printer cable.

The wrong printer 
driver was 
selected.

Check the application’s printer 
selection menu to ensure that 
your printer is selected.

The software 
application is 
malfunctioning.

Try printing a job from another 
application.

If you are in the 
DOS 
environment, the 
font setting for 
your machine 
may be set 
incorrectly.

Change the font setting. See 
page 1.6.

Condition Possible cause Suggested solutions
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Pages print, 
but are 
blank.

The print 
cartridge is 
defective or out of 
toner.

Redistribute the print cartridge. 
See page 8.2.
If necessary, replace the print 
cartridge. See page 8.3.

The file may have 
blank pages.

Check the file to ensure that it 
does not contain blank pages.

Some parts, such 
as the controller 
or the board, may 
be defective.

Contact a service 
representative.

The 
illustrations 
print 
incorrectly in 
Adobe 
Illustrator.

The setting in the 
software 
application is 
wrong.

Select Download as Bitmap in 
the Advanced Options window 
of the graphic properties. Print 
the document again.

The printer 
does not 
print PDF file 
correctly. 
Some parts 
of graphics, 
text, or 
illustrations 
are missing.

Incompatibility 
between the PDF 
file and the 
Acrobat products.

Printing the PDF file as an 
image may solve this problem. 
Turn on Print As Image from 
the Acrobat printing options.
Note: It will take longer to print 
when you print a PDF file as an 
image.

Condition Possible cause Suggested solutions Solving print quality problems
Dirt inside of the printer or improper paper loading may reduce print 
quality. See the table below to troubleshoot problems. 

Condition Suggested solutions

Light or faded 
print

If a vertical white streak or faded area appears 
on the page:
• The toner supply is low. You may be able to 

temporarily extend the print cartridge life. See 
page 8.2. If this does not improve print quality, 
install a new print cartridge.

• The paper may not meet paper specifications 
(for example, the paper is too moist or too 
rough). See page 5.3.

• If the entire page is light, the print resolution 
setting is too light or toner save mode is on. 
Adjust the print resolution and toner save 
mode in the printer properties. See the 
Software Section.

• A combination of faded or smeared defects 
may indicate that the printer needs cleaning. 
See page 8.1.

• The surface of LSU may be dirty. Clean the 
LSU. See page 8.2.

Toner spots • The paper may not meet specifications (for 
example, the paper is too moist or too rough). 
See page 5.3.

• The transfer roller or paper path may be dirty. 
See page 8.1.

Dropouts If generally rounded, faded areas occur 
randomly on the page:
• A single sheet of paper may be defective. Try 

reprinting the job.
• The moisture content of the paper is uneven 

or the paper has moist spots on its surface. 
Try a different brand of paper. See page 5.3.

• The paper lot is bad. The manufacturing 
processes can cause some areas to reject 
toner. Try a different kind or brand of paper.

• The print cartridge may be defective. See 
“Vertical repetitive defects” on the next 
column.

• If these steps do not correct the problems, 
contact a service representative.
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Vertical lines If black vertical streaks appear on the page:
• The drum inside the print cartridge has 

probably been scratched. Install a new print 
cartridge. See page 8.3.

If white vertical streaks appear on the page:
• The surface of the LSU part inside the printer 

may be dirty. Clean the LSU. See page 8.2.

Gray 
background

If the amount of background shading becomes 
unacceptable, the procedures below may fix the 
problem.
• Change to lighter weight paper. See page 5.3.
• Check the printer’s environment; low humidity 

(lower than 20% RH) or high humidity (higher 
than 80% RH) conditions can increase the 
amount of background shading.

• Remove the old print cartridge and install a 
new one. See page 8.3.

Toner smear • Clean the inside of the printer. See page 8.1.
• Check the paper type and quality. See page 

5.2.
• Remove the print cartridge and install a new 

one. See page 8.3.

Vertical 
repetitive 
defects

If marks repeatedly appear on the printed side of 
the page at even intervals:
• The print cartridge may be damaged. If a 

repetitive mark occurs on the page, install a 
new print cartridge. See page 8.3.

• Parts of the printer may have toner on them. If 
the defects occur on the back of the page, the 
problem will likely correct itself after a few 
more pages.

• The fusing assembly may be damaged. 
Contact a service representative.

Condition Suggested solutions

Background 
scatter

Background scatter results from bits of toner 
distributed on the printed page. 
• The paper may be too damp. Try printing with 

a different batch of paper. Do not open 
packages of paper until necessary so that the 
paper does not absorb too much moisture.

• If background scatter occurs on an envelope, 
change the printing layout to avoid printing 
over areas that have overlapping seams on 
the reverse side. Printing on seams can cause 
problems.

• If background scatter covers the entire 
surface area of a printed page, adjust the print 
resolution through your software application or 
via the printer properties window.

Misformed 
characters

• If characters are improperly formed and 
producing hollowed images, the paper stock 
may be too slick. Try a different paper. See 
page 5.3.

Page skew • Ensure that the paper is loaded properly.
• Check the paper type and quality. See page 

5.2.
• Ensure that the paper is loaded correctly and 

the adjustable guides are not too tight or too 
loose against the paper stack.

Curl or wave • Ensure that the paper is loaded properly.
• Check the paper type and quality. Both high 

temperature and humidity can cause paper 
curl. See page 5.2.

• Turn over the stack of paper in the tray. Also 
try rotating the paper 180° in the tray.

Condition Suggested solutions
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Wrinkles or 
creases

• Ensure that the paper is loaded properly.
• Check the paper type and quality. See page 

5.2.
• Turn over the stack of paper in the tray. Also 

try rotating the paper 180° in the tray.

Back of 
printouts are 
dirty

• The transfer roller may be dirty. See page 8.1.
• Check for leaking toner. Clean the inside of 

the printer. 

Solid black 
pages

• The print cartridge may not be installed 
properly. Remove the cartridge and reinsert.

• The print cartridge may be defective and need 
replacing. Install a new print cartridge.

• The printer may require repair. Contact a 
service representative.

Loose toner • Clean the inside of the printer. 
• Check the paper type and quality. See page 

5.2.
• Install a new print cartridge. See page 8.3.
• If the problem persists, the printer may require 

repair. Contact a service representative.

Character voids Character voids are white areas within 
characters that should be solid black:
• If you are using transparencies, try another 

type of transparency. Because of the 
composition of the transparency, some 
character voids may be normal. 

• You may be printing on the wrong surface on 
the paper. Turn over the paper in the tray. 

• The paper may not meet paper specifications. 
See page 5.3.

Condition Suggested solutions

Common Windows problems

Horizontal 
stripes

If horizontally aligned black streaks or smears 
appear:
• The print cartridge may be installed 

improperly. Remove the cartridge and 
reinsert.

• The print cartridge may be defective. Install a 
new print cartridge. See page 8.3.

• If the problem persists, the printer may require 
repair. Contact a service representative.

Curl If the printed paper is curled or paper does not 
feed into the printer:
• Turn over the stack of paper in the tray. Also 

try rotating the paper 180° in the tray.

An unknown 
image repetitively 
appears on a 
next few sheets 
or loose toner, 
light print or 
contamination 
occurs.

Your printer is probably being used at an altitude 
of 1,000 m (3,281 ft) or above.
The high altitude may affect the print quality 
such as loose toner or light imaging. You can set 
this option through Printer Settings Utility or 
Printer tab in printer driver’s properties. See 
page 1.5.

Condition Suggested solutions

“General Protection 
Fault”, “Exception 
OE”, “Spool32”, or 
“Illegal Operation” 
messages appear.

Close all other applications, reboot Windows, 
and try printing again.

“Fail To Print”, “A 
printer timeout error 
occurred,” 
messages appear.

These messages may appear during printing. 
Just keep waiting until the printer finishes 
printing. If the message appears in standby 
mode or after printing has been completed, 
check the connection and/or whether an error 
has occurred.

Note
• Refer to Microsoft Windows 2000/XP/2003/Vista User’s Guide 

that came with your PC for further information on Windows 
error messages.

Condition Suggested solutions
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Common PostScript problems
The following situations are PostScript language specific and may occur 
when several printer languages are being used.

Note
• To view a printed or screen displayed message when 

PostScript errors occur, open the Print Options window and 
click the desired selection next to the PostScript errors section.

Condition Possible cause Suggested solutions

PostScript file 
can not be 
printed.

The PostScript 
driver may not 
be installed 
correctly.

• Print a configuration page 
and verify that the PostScript 
version is available for 
printing.

• Install the PostScript driver; 
to installing the PS printer 
driver, see the Software 
Section.

• If problem consists, contact a 
service representative.

“Limit Check 
Error” message 
appears.

The print job 
was too 
complex.

You might need to reduce the 
complexity of the page.

A PostScript 
error page 
prints.

Print job may 
not be 
PostScript.

Make sure that the print job is a 
PostScript job. Check to see 
whether the software 
application expected a setup or 
PostScript header file to be sent 
to the printer.

When print a 
document in 
Macintosh with 
Acrobat Reader 
6.0 or higher, 
colors print 
incorrectly.

The resolution 
setting in the 
printer driver 
may not be 
matched with 
that in Acrobat 
Reader.

Make sure that the resolution 
setting in your printer driver 
matches that in Acrobat 
Reader.

Common Linux problems

Condition Suggested solutions

The printer doesn’t 
print.

• Check if the printer driver is installed in your 
system. Open Unified Driver Configurator 
and switch to the Printers tab in Printers 
configuration window to look at the list of 
available printers. Make sure that your 
machine is displayed on the list. If not, 
please, invoke Add new printer wizard to set 
up your device. 

• Check if the printer is started. Open Printers 
configuration and select your machine on 
the printers list. Look at the description in 
the Selected printer pane. If its status 
contains “(stopped)” string, please, press 
the Start button. After that normal operation 
of the printer should be restored. The 
"stopped" status might be activated when 
some problems in printing occurred. 

• Check if your application has special print 
option such as “-oraw”. If “-oraw” is 
specified in the command line parameter 
then remove it to print properly. For Gimp 
front-end, select “print” -> “Setup printer” 
and edit command line parameter in the 
command item.

I encounter error 
“Unable to open 
mfp port device 
file!” when printing 
a document.

Please avoid changing print job parameters 
(via LPR GUI, for example) while a print job is 
in progress. Known versions of CUPS server 
break the print job whenever print options are 
changed and then try to restart the job from 
the beginning. Since Unified Linux Driver 
locks mfp port while printing, the abrupt 
termination of the driver keeps the port locked 
and therefore unavailable for subsequent print 
jobs. If this situation occurred, please, try to 
release the mfp port.

When printing a 
document over the 
network in SuSE 
9.2, the printer 
does not print.

The CUPS (Common Unix Printing System) 
version distributed with SuSE Linux 9.2 
(cups-1.1.21) has a problem with ipp 
(Internet Printing Protocol) printing. Use the 
socket printing instead of ipp or install later 
version of CUPS (cups-1.1.22 or higher).
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Common Macintosh problems

Condition Suggested solutions

The printer does not 
print PDF file correctly. 
Some parts of graphics, 
text, or illustrations are 
missing.

Incompatibility between the PDF file and 
the Acrobat products:
Printing the PDF file as an image may 
solve this problem. Turn on Print As 
Image from the Acrobat printing options.
Note: It will take longer to print when you 
print a PDF file as an image.

The document has 
printed, but the print job 
has not disappeared 
from the spooler in Mac 
OS 10.3.2.

Update your Mac OS to OS 10.3.3 or 
higher.

Some characters are not 
displayed correctly 
during the printing of the 
cover sheet.

This problem is caused because Mac OS 
cannot find the font during the cover 
page printing. 
Alphanumeric characters, in the Billing 
Info field, are only allowed to be printed 
on the cover page. Other characters will 
be incorrectly displayed on the output.
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10 Installing additional memory
Your machine is a full-featured model that has been optimized to meet 
most of your printing needs. Recognizing that each user may have 
different requirements, however, Xerox makes additional memory 
available to enhance your machine’s capabilities.

This chapter includes:
• Precautions to take when installing memory
• Installing a memory module

Precautions to take when installing memory

Disconnect the power cord
Never remove the expansion memory cover while the power is turned on.

To avoid the possibility of an electrical shock, always disconnect the 
power cord when installing or removing ANY internal or external 
accessories.

Discharge static electricity
The control board and internal accessories (network interface card or 
memory module) are sensitive to static electricity. Before installing or 
removing any internal accessories, discharge static electricity from your 
body by touching something metal, such as the metal back plate on any 
device plugged into a grounded power source. If you walk around before 
finishing the installation, repeat this procedure to discharge any static 
electricity again.

Installing a memory module
Your machine has a dual in-line memory module (DIMM). Use this 
memory module slot to install additional memory.

When you are expanding the memory capacity, you can add a memory 
module to the vacant memory slot. Your machine has 32 MB memory, 
and you can add a 128 MB memory module.

Order information is provided for optional memory module. (See 
"Accessories" on page 7.1.)

1 Turn the machine off and unplug all cables from the machine.

2 Open the expansion memory cover.

3 Take out a new memory module from the plastic bag.

4 Holding the memory module by the edges, align the memory 
module on the slot at about a 30-degree tilt. Make sure that the 
notches of the module and the grooves on the slot fit each other.

Note
The notches and grooves illustrated above may not match 
those on an actual memory module and its slot.

5 Press the memory module into the slot with care until you hear a 
“click”. 

Caution 
Do not press too hard or the module may be damaged. If 
the module does not seem to fit into the slot properly, 
carefully try the previous procedure again.

6 Replace the expansion memory cover.

7 Reconnect the power cord and printer cable, and turn the machine 
on.

Note
To release the memory module, pull the two tabs on the 
sides of the slot outwards, then the module springs out. 

3250-008

3250-006

3250-007
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Activating the added memory in the PS printer 
properties
After installing the memory module, you need to select it in the printer 
properties of the PostScript printer driver in order to use it.

1 Make sure that the PostScript printer driver is installed on your 
computer. For details about installing the PS printer driver, see the 
Software section.

2 Click the Windows Start menu.

3 For Windows 2000, select Settings and then Printers.

For Windows XP/2003, select Printers and Faxes.

For Windows Vista, select Control Panel > Hardware and Sound 
> Printers.

4 Select the Xerox Phaser 3250 PS printer.

5 Click the right mouse button on the printer icon and select 
Properties.

6 For Windows 2000/XP/2003/Vista, select Device Settings.

7 Select the amount of memory you installed from Printer Memory in 
the Installable Options section.

8 Click OK.
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11 Specifications

Printer specifications

Item Specifications and description

Printing speeda Up to 28 ppm in A4 (30 ppm in Letter)
Duplex: 14 ipm in A4 (14.5 ipm in Letter)

Resolution Up to 1200 x 1200 dpi effective output

Warm-up time Less than 15 seconds

First print out 
time

8.5 seconds (From Ready)
Sleep mode: 23.5 seconds

Power rating AC 110-127 V or AC 220-240 V
See the Rating label on the machine for the correct 
voltage, frequency (hertz) and type of current for 
your machine.

Power 
consumption

Average: 400 W 
Power save mode: Less than 8 W 

Noise levelb Standby mode: Less than 26 dBA
Printing mode: Less than 50 dBA

Print cartridge 
lifec

Standard Yield: Average cartridge yield 3,500d 
standard pages.
High Yield: Average cartridge yield 5,000 
standard pages.
Starter cartridge shipped with the printer runs a 
lower yield.

Duty cycle Monthly: Up to 30,000 pages

Weight 11.9 Kg (including consumables)

Package weight Paper: 2.4 Kg, Plastic: 0.3 Kg

Memory 32 MB 

External 
dimensions
(W x D x H)

364 x 395 x 200 mm (15.2 x 17.2 x 10.5 inches) 

Operating 
environment

Temperature: 10 to 32°C (50 to 90°F)
Humidity: 20 to 80% RH

Printer language PCL6e, IBM ProPrinter, EPSON, PostScript 3, 
SPL

Fonts 1 bitmap, 45 scalable, 136 PostScript 3 fonts

Interface • USB Interface Standard
   - USB 2.0: Hi-Speed USB 2.0
• Network Interface 
   - Ethernet 10/100 Base TX wired LAN 

(Phaser 3250DN only)

OS compatibility • Windows 2000/2003 Server/XP (32/64 bit)/Vista
• Various Linux OS
• Mac 10.3~10.5

Printer driversf • PCL6 driver: Windows 2000/ 2003 Server/XP 
(32/64 bit)/Vista

• PostScript driver: Windows 2000/ 2003 Server/
XP (32/64 bit)/Vista

Options 250-sheet tray

Fusing 
temperature

180° C (356° F)

a. Print speed will be affected by operating system used, computing perfor-
mance, application software, connection method, print media type, print media 
size, and job complexity.

b. Sound pressure Level, ISO7779.
c. The number of pages may be affected by operating environment, printing inter-

val, print media type, and print media size.
d. Declared yield value in accordance with ISO/IEC 19752.
e. Compatible with PCL6 version 2.1.
f. Please visit www.xerox.com to download the latest software version.

Item Specifications and description

http://www.xerox.com
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12 Glossary

ADF
An Automatic Document Feeder (ADF) is a mechanism that will 
automatically feed an original sheet of paper so that the machine 
can scan some amount of the paper at once. 

AppleTalk
AppleTalk is a proprietary suite of protocols developed by Apple, Inc 
for computer networking. It was included in the original Macintosh 
(1984) and is now deprecated by Apple in favor of TCP/IP 
networking.

BIT Depth
A computer graphics term describing the number of bits used to 
represent the color of a single pixel in a bitmapped image. Higher 
color depth gives a broader range of distinct colors. As the number 
of bits increases, the number of possible colors becomes 
impractically large for a color map. 1-bit color is commonly called as 
monochrome or black and white.

BMP
A bitmapped graphics format used internally by the Microsoft 
Windows graphics subsystem (GDI), and used commonly as a 
simple graphics file format on that platform.

BOOTP
Bootstrap Protocol. A network protocol used by a network client to 
obtain its IP address automatically. This is usually done in the 
bootstrap process of computers or operating systems running on 
them. The BOOTP servers assign the IP address from a pool of 
addresses to each client. BOOTP enables 'diskless workstation' 
computers to obtain an IP address prior to loading any advanced 
operating system.

CCD 
Charge Coupled Device (CCD) is a hardware which enables the 
scan job. CCD Locking mechanism is also used to hold the CCD 
module to prevent any damage when you move the machine.

Collation
Collation is a process of printing a multiple-copy job in sets. When 
collation is selected, the device prints an entire set before printing 
additional copies.

Control Panel
A control panel is a flat, typically vertical, area where control or 
monitoring instruments are displayed. They are typically found in 
front of the machine. 

Coverage 
It is the printing term used for a toner usage measurement on 
printing. For example, 5% coverage means that an A4 sided paper 
has about 5% image or text on it. So, if the paper or original has 
complicated images or lots of text on it, the coverage will be higher 
and at the same time, a toner usage will be as much as the 
coverage.

The following glossary helps you get familiar with the product by 
understanding the terminologies commonly used with printing as 
well as mentioned in this user guide.

CSV
Comma Separated Values (CSV). A type of file format, CSV is used 
to exchange data between disparate applications. The file format, 
as it is used in Microsoft Excel, has become a pseudo standard 
throughout the industry, even among non-Microsoft platforms.

DADF
A Duplex Automatic Document Feeder (DADF) is a mechanism that 
will automatically feed and flip over an original sheet of paper so that 
the machine can scan on both sides of the paper.

Default
The value or setting that is in effect when taking a printer out of its 
box state, reset, or initialized.

DHCP
A Dynamic Host Configuration Protocol (DHCP) is a client-server 
networking protocol. A DHCP server provides configuration 
parameters specific to the DHCP client host requesting, generally, 
information required by the client host to participate on an IP 
network. DHCP also provides a mechanism for allocation of IP 
addresses to client hosts.

DIMM
Dual Inline Memory Module (DIMM), a small circuit board that holds 
memory. DIMM stores all the data within the machine like printing 
data, received fax data.

DNS
The Domain Name Server (DNS) is a system that stores information 
associated with domain names in a distributed database on 
networks, such as the Internet.

Dot Matrix Printer
A dot matrix printer refers to a type of computer printer with a print 
head that runs back and forth on the page and prints by impact, 
striking an ink-soaked cloth ribbon against the paper, much like a 
typewriter.

DPI
Dots Per Inch (DPI) is a measurement of resolution that is used for 
scanning and printing. Generally, higher DPI results in a higher 
resolution, more visible detail in the image, and a larger file size.

DRPD 
Distinctive Ring Pattern Detection. Distinctive Ring is a telephone 
company service which enables a user to use a single telephone 
line to answer several different telephone numbers.

Duplex
A mechanism that will automatically flip over a sheet of paper so 
that the machine can print (or scan) on both sides of the paper. A 
printer equipped with a Duplex can print double-sided of paper.

Duty Cycle
Duty cycle is the page quantity which does not affect printer 
performance for a month. Generally the printer has the lifespan 
limitation such as pages per year. The lifespan means the average 
capacity of print-outs, usually within the warranty period. For 
example, if the duty cycle is 48,000 pages per month assuming 20 
working days, a printer limits 2,400 pages a day.

ECM
Error Correction Mode (ECM) is an optional transmission mode built 
into Class 1 fax machines or fax modems. It automatically detects 
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and corrects errors in the fax transmission process that are 
sometimes caused by telephone line noise.

Emulation
Emulation is a technique of one machine obtaining the same results 
as another.
An emulator duplicates the functions of one system with a different 
system, so that the second system behaves like the first system. 
Emulation focuses on exact reproduction of external behavior, 
which is in contrast to simulation, which concerns an abstract model 
of the system being simulated, often considering its internal state.

Ethernet
Ethernet is a frame-based computer networking technology for local 
area networks (LANs). It defines wiring and signaling for the 
physical layer, and frame formats and protocols for the media 
access control (MAC)/data link layer of the OSI model. Ethernet is 
mostly standardized as IEEE 802.3. It has become the most 
widespread LAN technology in use during the 1990s to the present.

EtherTalk
A suite of protocols developed by Apple Computer for computer 
networking. It was included in the original Macintosh (1984) and is 
now deprecated by Apple in favor of TCP/IP networking. 

FDI
Foreign Device Interface (FDI) is a card installed inside the machine 
to allow a third party device such as a coin operated device or a 
card reader. Those devices allow the pay-for-print service on your 
machine.

FTP
A File Transfer Protocol (FTP) is a commonly used protocol for 
exchanging files over any network that supports the TCP/IP protocol 
(such as the Internet or an intranet).

Fuser Unit 
The part of a laser printer that melts the toner onto the print media. It 
consists of a hot roller and a back-up roller. After toner is transferred 
onto the paper, the fuser unit applies heat and pressure to ensure 
that the toner stays on the paper permanently, which is why paper is 
warm when it comes out of a laser printer.

Gateway
A connection between computer networks, or between a computer 
network and a telephone line. It is very popular, as it is a computer 
or a network that allows access to another computer or network.

Grayscale
A shades of gray that represent light and dark portions of an image 
when color images are converted to grayscale; colors are 
represented by various shades of gray.

Halftone
An image type that simulates grayscale by varying the number of 
dots. Highly colored areas consist of a large number of dots, while 
lighter areas consist of a smaller number of dots.

HDD
Hard Disk Drive (HDD), commonly referred to as a hard drive or 
hard disk, is a non-volatile storage device which stores digitally-
encoded data on rapidly rotating platters with magnetic surfaces.

IEEE
The Institute of Electrical and Electronics Engineers (IEEE) is an 
international non-profit, professional organization for the 
advancement of technology related to electricity.

IEEE 1284
The 1284 parallel port standard was developed by the Institute of 
Electrical and Electronics Engineers (IEEE). The term "1284-B" 
refers to a specific connector type on the end of the parallel cable 
that attaches to the peripheral (for example, a printer). 

Intranet
A private network that uses Internet Protocols, network connectivity, 
and possibly the public telecommunication system to securely share 
part of an organization's information or operations with its 
employees. Sometimes the term refers only to the most visible 
service, the internal website.

IP address
An Internet Protocol (IP) address is a unique number that devices 
use in order to identify and communicate with each other on a 
network utilizing the Internet Protocol standard.

IPM
The Images Per Minute (IPM) is a way of measuring the speed of a 
printer. An IPM rate indicates the number of single-sided sheets a 
printer can complete within one minute.

IPP
The Internet Printing Protocol (IPP) defines a standard protocol for 
printing as well as managing print jobs, media size, resolution, and 
so forth. IPP can be used locally or over the Internet to hundreds of 
printers, and also supports access control, authentication, and 
encryption, making it a much more capable and secure printing 
solution than older ones.

IPX/SPX
IPX/SPX stands for Internet Packet Exchange/Sequenced Packet 
Exchange. It is a networking protocol used by the Novell NetWare 
operating systems. IPX and SPX both provide connection services 
similar to TCP/IP, with the IPX protocol having similarities to IP, and 
SPX having similarities to TCP. IPX/SPX was primarily designed for 
local area networks (LANs), and is a very efficient protocol for this 
purpose (typically its performance exceeds that of TCP/IP on a 
LAN).

ISO
The International Organization for Standardization (ISO) is an 
international standard-setting body composed of representatives 
from national standards bodies. It produces world-wide industrial 
and commercial standards.

ITU-T
The International Telecommunication Union is an international 
organization established to standardize and regulate international 
radio and telecommunications. Its main tasks include 
standardization, allocation of the radio spectrum, and organizing 
interconnection arrangements between different countries to allow 
international phone calls. A -T out of ITU-T indicates 
telecommunication.

ITU-T No. 1 chart
Standardized test chart published by ITU-T for document facsimile 
transmissions.
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JBIG
Joint Bi-level Image Experts Group (JBIG) is an image compression 
standard with no loss of accuracy or quality, which was designed for 
compression of binary images, particularly for faxes, but can also be 
used on other images.

JPEG
Joint Photographic Experts Group (JPEG) is a most commonly used 
standard method of lossy compression for photographic images. It 
is the format used for storing and transmitting photographs on the 
World Wide Web.

LDAP
The Lightweight Directory Access Protocol (LDAP) is a networking 
protocol for querying and modifying directory services running over 
TCP/IP.

LED
A Light-Emitting Diode (LED) is a semiconductor device that 
indicates the status of a machine. 

MAC address
Media Access Control (MAC) address is a unique identifier 
associated with a network adapter. MAC address is a unique 48-bit 
identifier usually written as 12 hexadecimal characters grouped in 
pairs (e. g., 00-00-0c-34-11-4e). This address is usually hard-coded 
into a Network Interface Card (NIC) by its manufacturer, and used 
as an aid for routers trying to locate machines on large networks.

MFP
Multi Function Peripheral (MFP) is an office machine that includes 
the following functionality in one physical body, so as to have a 
printer, a copier, a fax, a scanner and etc.

MH
Modified Huffman (MH) is a compression method for decreasing the 
amount of data that needs to be transmitted between the fax 
machines to transfer the image recommended by ITU-T T.4. MH is a 
codebook-based run-length encoding scheme optimized to 
efficiently compress white space. As most faxes consist mostly of 
white space, this minimizes the transmission time of most faxes. 

MMR
Modified Modified READ (MMR) is a compression method 
recommended by ITU-T T.6.

Modem
A device that modulates a carrier signal to encode digital 
information, and also demodulates such a carrier signal to decode 
transmitted information.

MR
Modified Read (MR) is a compression method recommended by 
ITU-T T.4. MR encodes the first scanned line using MH. The next 
line is compared to the first, the differences determined, and then 
the differences are encoded and transmitted.

NetWare
A network operating system developed by Novell, Inc. It initially 
used cooperative multitasking to run various services on a PC, and 
the network protocols were based on the archetypal Xerox XNS 
stack. Today NetWare supports TCP/IP as well as IPX/SPX.

OPC
Organic Photo Conductor (OPC) is a mechanism that makes a 
virtual image for print using a laser beam emitted from a laser 
printer, and it is usually green or gray colored and a cylinder 
shaped. 
An exposing unit of a imaging is slowly worn away by its usage of 
the printer, and it should be replaced appropriately since it gets 
scratches from grits of a paper.

Originals
The first example of something, such as a document, photograph or 
text, etc, which is copied, reproduced or translated to produce 
others, but which is not itself copied or derived from something else.

OSI
Open Systems Interconnection (OSI) is a model developed by the 
International Organization for Standardization (ISO) for 
communications. OSI offers a standard, modular approach to 
network design that divides the required set of complex functions 
into manageable, self-contained, functional layers. The layers are, 
from top to bottom, Application, Presentation, Session, Transport, 
Network, Data Link and Physical.

PABX 
A private automatic branch exchange (PABX) is an automatic 
telephone switching system within a private enterprise.

PCL
Printer Command Language (PCL) is a Page Description Language 
(PDL) developed by HP as a printer protocol and has become an 
industry standard. Originally developed for early inkjet printers, PCL 
has been released in varying levels for thermal, matrix printer, and 
page printers.

PDF
Portable Document Format (PDF) is a proprietary file format 
developed by Adobe Systems for representing two dimensional 
documents in a device independent and resolution independent 
format.

PostScript
PostScript (PS) is a page description language and programming 
language used primarily in the electronic and desktop publishing 
areas. - that is run in an interpreter to generate an image.

Printer Driver
A program used to send commands and transfer data from the 
computer to the printer.

Print Media
The media like paper, envelopes, labels, and transparencies which 
can be used on a printer, a scanner, a fax or, a copier.

PPM
Pages Per Minute (PPM) is a method of measurement for 
determining how fast a printer works, meaning the number of pages 
a printer can produce in one minute.

PRN file
An interface for a device driver, this allows software to interact with 
the device driver using standard input/output system calls, which 
simplifies many tasks. 
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Protocol
A convention or standard that controls or enables the connection, 
communication, and data transfer between two computing 
endpoints.

PS
See PostScript.

PSTN
The Public-Switched Telephone Network (PSTN) is the network of 
the world's public circuit-switched telephone networks which, on 
industrial premises, is usually routed through the switchboard.

Resolution
The sharpness of an image, measured in Dots Per Inch (DPI). The 
higher the dpi, the greater the resolution.

SMB
Server Message Block (SMB) is a network protocol mainly applied 
to share files, printers, serial ports, and miscellaneous 
communications between nodes on a network. It also provides an 
authenticated Inter-process communication mechanism.

SMTP
Simple Mail Transfer Protocol (SMTP) is the standard for e-mail 
transmissions across the Internet. SMTP is a relatively simple, 
text-based protocol, where one or more recipients of a message are 
specified, and then the message text is transferred. It is a 
client-server protocol, where the client transmits an email message 
to the server.

Subnet Mask 
The subnet mask is used in conjunction with the network address to 
determine which part of the address is the network address and 
which part is the host address.

TCP/IP
The Transmission Control Protocol (TCP) and the Internet Protocol 
(IP); the set of communications protocols that implement the 
protocol stack on which the Internet and most commercial networks 
run.

TCR
Transmission Confirmation Report (TCR) provides details of each 
transmission such as job status, transmission result and number of 
pages sent. This report can be set to print after each job or only after 
failed transmissions.

TIFF
Tagged Image File Format (TIFF) is a variable-resolution bitmapped 
image format. TIFF describes image data that typically come from 
scanners. TIFF images make use of tags, keywords defining the 
characteristics of the image that is included in the file. This flexible 
and platform-independent format can be used for pictures that have 
been made by various image processing applications.

Print Cartridge
A kind of bottle within a machine like printer which contains toner. 
Toner is a powder used in laser printers and photocopiers, which 
forms the text and images on the printed paper. Toner can be 
melted by the heat of the fuser, causing it to bind to the fibers in the 
paper.

TWAIN
An industry standard for scanners and software. By using a TWAIN-
compliant scanner with a TWAIN-compliant program, a scan can be 
initiated from within the program; an image capture API for Microsoft 
Windows and Apple Macintosh operating systems.

UNC Path
Uniform Naming Convention (UNC) is a standard way to access 
network shares in Window NT and other Microsoft products. The 
format of a UNC path is: \\<servername>\<sharename>\<Additional 
directory>.

URL
Uniform Resource Locator (URL) is the global address of 
documents and resources on the Internet. The first part of the 
address indicates what protocol to use, the second part specifies 
the IP address or the domain name where the resource is located.

USB
Universal Serial Bus (USB) is a standard that was developed by the 
USB Implementers Forum, Inc., to connect computers and 
peripherals. Unlike the parallel port, USB is designed to 
concurrently connect a single computer USB port to multiple 
peripherals.

Watermark
A watermark is a recognizable image or pattern in paper that 
appears lighter when viewed by transmitted light. Watermarks were 
first introduced in Bologna, Italy in 1282; they have been used by 
papermakers to identify their product, and also on postage stamps, 
currency, and other government documents to discourage 
counterfeiting.

WIA
Windows Imaging Architecture (WIA) is an imaging architecture that 
is originally introduced in Windows Me and Windows XP. A scan 
can be initiated from within these operating systems by using a 
WIA-compliant scanner.
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1 Installing Printer Software in 
Windows
This chapter includes:

• Installing Printer Software

• Reinstalling Printer Software

• Removing Printer Software

NOTE: The following procedure is based on Windows XP, for other 
operating systems, refer to the corresponding Windows user's guide 
or online help.

Installing Printer Software
You can install the printer software for local printing and/or network 
printing. To install the printer software on the computer, perform the 
appropriate installation procedure depending on the printer in use.

A printer driver is software that lets your computer communicate with 
your printer. The procedure to install drivers may differ depending on the 
operating system you are using.

All applications should be closed on your PC before beginning 
installation. 

NOTE (Phaser 3250DN only): You can install PostScript printer 
driver, when Phaser 3250DN is attached to your computer or a 
network. 

Installing Software for Local Printing
A local printer is a printer directly attached to your computer using the 
USB printer cable supplied with your printer. If your printer is attached to 
a network, skip this step and go to “Installing Software for Network 
Printing” on page 6.

You can install the printer software using the typical or custom method.

NOTE: If the “New Hardware Wizard” window appears during the 
installation procedure, click  in the upper right corner of the box 
to close the window, or click Cancel.

Typical Installation

This is recommended for most users. All components necessary for 
printer operations will be installed.

1 Make sure that the printer is connected to your computer and 
powered on.

2 Insert the supplied CD-ROM into your CD-ROM drive.
The CD-ROM should automatically run, and an installation 
window appears.
If the installation window does not appear, click Start and then 
Run. Type X:\Setup.exe, replacing “X” with the letter which 
represents your drive and click OK.
If you use Windows Vista, click Start → All programs → 
Accessories → Run, and type X:\Setup.exe.
If the AutoPlay window appears in Windows Vista, click Run 
Setup.exe in Install or run program field, and click Continue 
in the User Account Control window.

3 Click Install Software. 

4 Select Typical installation for a local printer. Click Next.
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NOTE: If your printer is not already connected to the computer, the 
following window will appear.

• After connecting the printer, click Next.
• If you don’t want to connect the printer at this time, click Next, and 

No on the following screen. Then the installation will start and a 
test page will not be printed at the end of the installation.

• The installation window that appears in this User Guide may 
differ depending on the printer and interface in use.

5 After the installation is finished, a window asking you to print a 
test page appears. If you choose to print a test page, select the 
checkbox and click Next.
Otherwise, just click Next and skip to step 7.

6 If the test page prints out correctly, click Yes.
If not, click No to reprint it.

7 Click Finish.

NOTE: After setup is complete, if your printer driver does not work 
properly, check the printer and power cables to make sure they are 
connected properly, then reinstall the printer driver. See 
“Reinstalling Printer Software” on page 9.

Custom Installation

You can choose individual components to install.

1 Make sure that the printer is connected to your computer and 
powered on.

2 Insert the supplied CD-ROM into your CD-ROM drive.
The CD-ROM should automatically run, and an installation 
window appears.
If the installation window does not appear, click Start and then 
Run. Type X:\Setup.exe, replacing “X” with the letter which 
represents your drive and click OK.
If you use Windows Vista, click Start → All programs → 
Accessories → Run, and type X:\Setup.exe.
If the AutoPlay window appears in Windows Vista, click Run 
Setup.exe in Install or run program field, and click Continue 
in the User Account Control window.

3 Click Install Software. 

4 Select Custom installation. Click Next.
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5 Select your printer and click Next.

NOTE: If your printer is not already connected to the computer, the 
following window will appear.

• After connecting the printer, click Next.
• If you don’t want to connect the printer at this time, click Next, and 

No on the following screen. Then the installation will start and a 
test page will not be printed at the end of the installation.

• The installation window that appears in this User Guide may 
differ depending on the printer and interface in use.

6 Select the components to be installed and click Next.

NOTE: You can change the desired installation folder by clicking 
[Browse].

7 After the installation is finished, a window asking you to print a 
test page appears. If you choose to print a test page, select the 
checkbox and click Next.
Otherwise, just click Next and skip to step 9.

8 If the test page prints out correctly, click Yes.
If not, click No to reprint it.

9 Click Finish.

Installing Software for Network Printing

Before you begin

Before turning on the machine:
• Confirm that an existing operational network utilizing TCP/IP is 

available.
• Confirm that the Ethernet cable is plugged into the machine and is 

connected to an operational Ethernet port on the network.

When you connect your printer to a network, you must first configure the 
TCP/IP settings for the printer. After you have assigned and verified the 
TCP/IP settings, you are ready to install the software on each computer 
on the network.

You can install the printer software using the typical or custom method.

Typical Installation

This is recommended for most users. All components necessary for 
printer operations will be installed.

1 Make sure that the printer is connected to your network and 
powered on. For details about connecting to the network, see 
the supplied printer’s User Guide.

2 Insert the supplied CD-ROM into your CD-ROM drive.
The CD-ROM should automatically run, and an installation 
window appears.
If the installation window does not appear, click Start and then 
Run. Type X:\Setup.exe, replacing “X” with the letter which 
represents your drive and click OK.
If you use Windows Vista, click Start → All programs → 
Accessories → Run, and type X:\Setup.exe.
If the AutoPlay window appears in Windows Vista, click Run 
Setup.exe in Install or run program field, and click Continue 
in the User Account Control window.
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3 Click Install Software. 

4 Select Typical installation for a network printer. Click Next.

5 The list of printers available on the network appears. Select the 
printer you want to install from the list and then click Next. 

• If you do not see your printer on the list, click Update to 
refresh the list, or select Add TCP/IP Port to add your printer 
to the network. To add the printer to the network, enter the 
port name and the IP address for the printer.
To verify your printer’s IP address or the MAC address, print a 
Network Configuration page.

• To find a shared network printer (UNC Path), select Shared 
Printer [UNC] and enter the shared name manually or find a 
shared printer by clicking the Browse button.

NOTE: To search the network printer, the firewall should be disabled.

6 After the installation is finished, a window asking you to print a 
test page appears. If you choose to print a test page, select the 
checkbox and click Next.
Otherwise, just click Next and skip to step 8.

7 If the test page prints out correctly, click Yes.
If not, click No to reprint it.

8 Click Finish.

NOTE: After setup is complete, if your printer driver does not work 
properly, reinstall the printer driver. See “Reinstalling Printer 
Software” on page 9.

Custom Installation

You can choose individual components to install and set a specific IP 
address.

1 Make sure that the printer is connected to your network and 
powered on. For details about connecting to the network, see 
the supplied printer’s User Guide.

2 Insert the supplied CD-ROM into your CD-ROM drive.
The CD-ROM should automatically run, and an installation 
window appears.
If the installation window does not appear, click Start and then 
Run. Type X:\Setup.exe, replacing “X” with the letter which 
represents your drive and click OK.
If you use Windows Vista, click Start → All programs → 
Accessories → Run, and type X:\Setup.exe.
If the AutoPlay window appears in Windows Vista, click Run 
Setup.exe in Install or run program field, and click Continue 
in the User Account Control window.
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3 Click Install Software. 

4 Select Custom installation. Click Next.

5 The list of printers available on the network appears. Select the 
printer you want to install from the list and then click Next. 

• If you do not see your printer on the list, click Update to 
refresh the list, or select Add TCP/IP Port to add your printer 
to the network. To add the printer to the network, enter the 
port name and the IP address for the printer.
To verify your printer’s IP address or the MAC address, print a 
Network Configuration page.

• To find a shared network printer (UNC Path), select Shared 
Printer [UNC] and enter the shared name manually or find a 
shared printer by clicking the Browse button.

NOTE: To search the network printer, the firewall should be disabled.

TIP: If you want to set a specific IP address on a specific network 
printer, click the Set IP Address button. The Set IP Address window 
appears. Do as follows:

a. Select a printer to be set with a specific IP address from the list. 
To verify your printer’s IP address or MAC address, print a 
Network Configuration page.

b. Configure an IP address, subnet mask, and gateway for the 
printer manually and click Configure to set the specific IP 
address for the network printer.

c. Click Next.

6 Select the components to be installed and click Next.
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7 You can also change the printer name, set the printer to be 
shared on the network, set the printer as the default printer, and 
change the port name of each printer. Click Next.

To install this software on a server, select the Setting up this 
printer on a server checkbox.

8 After the installation is finished, a window asking you to print a 
test page appears. If you choose to print a test page, select the 
checkbox and click Next.
Otherwise, just click Next and skip to step 10.

9 If the test page prints out correctly, click Yes.
If not, click No to reprint it.

10 Click Finish.

NOTE: After setup is complete, if your printer driver does not work 
properly, reinstall the printer driver. See “Reinstalling Printer 
Software” on page 9.

Reinstalling Printer Software
You can reinstall the software if installation fails.

1 Start Windows.

2 From the Start menu select Programs or All Programs → 
your printer driver name → Maintenance.

3 Select Repair and click Next.

4 The list of printers available on the network appears. Select the 
printer you want to install from the list and then click Next. 

• If you do not see your printer on the list, click Update to 
refresh the list, or select Add TCP/IP Port to add your printer 
to the network. To add the printer to the network, enter the 
port name and the IP address for the printer.

• To find a shared network printer (UNC Path), select Shared 
Printer [UNC] and enter the shared name manually or find a 
shared printer by clicking the Browse button.

You will see a component list so that you can reinstall any item 
individually.

NOTE: If your printer is not already connected to the computer, the 
following window will appear.

• After connecting the printer, click Next.
• If you don’t want to connect the printer at this time, click Next, and 

No on the following screen. Then the installation will start and a 
test page will not be printed at the end of the installation.

• The reinstallation window that appears in this User Guide may 
differ depending on the printer and interface in use.
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5 Select the components you want to reinstall and click Next.
If you installed the printer software for local printing and you 
select your printer driver name, the window asking you to 
print a test page appears. Do as follows:
a. To print a test page, select the check box and click Next.
b. If the test page prints out correctly, click Yes.
If it doesn’t, click No to reprint it.

6 When the reinstallation is done, click Finish.

Removing Printer Software
1 Start Windows.

2 From the Start menu select Programs or All Programs → 
your printer driver name → Maintenance.

3 Select Remove and click Next.
You will see a component list so that you can remove any item 
individually.

4 Select the components you want to remove and then click 
Next.

5 When your computer asks you to confirm your selection, click 
Yes.
The selected driver and all of its components are removed from 
your computer.

6 After the software is removed, click Finish.
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2 Using SetIP (Phaser 3250DN 
only)
• Installing SetIP

• Using SetIP

Installing SetIP
1 Make sure that the printer is connected to your computer and 

powered on.

2 Insert the supplied CD-ROM into your CD-ROM drive.
The CD-ROM should automatically run, and an installation 
window appears.
If the installation window does not appear, click Start and then 
Run. Type X:\Setup.exe, replacing “X” with the letter which 
represents your drive and click OK.
If you use Windows Vista, click Start → All programs → 
Accessories → Run, and type X:\Setup.exe.
If the AutoPlay window appears in Windows Vista, click Run 
Setup.exe in Install or run program field, and click Continue 
in the User Account Control window.

3 Click Install SetIP Utility(Optional). 

4 Click Next. 

5 Click Next. 

6 Click Finish.

Using SetIP
1 From the Windows Start menu, select Programs or All 

Programs  Xerox Phaser 3250  SetIP  SetIP.
The program automatically detects and displays new and 
configured print servers on your network.
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2 Select the name of your printer and click . If you cannot 
find your printer name, click  to refresh the list.

NOTES: 
• To confirm the MAC address, see the NETWORK PRINTER 

CARD TEST PAGE. The NETWORK PRINTER CARD TEST 
PAGE will be printed after the Configuration Page.

• The refreshed list doesn’t show your printer, click  enter your 
network printer card’s IP address, subnet mask, default gateway, 
and then click Apply.

3 Click OK to confirm the settings.

4 Click Exit to close the SetIP program.
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3 Basic Printing 
This chapter explains the printing options and common printing tasks 
in Windows. 

This chapter includes:

• Printing a Document

• Printing to a file (PRN)

• Printer Settings

- Layout Tab

- Paper Tab

- Graphics Tab

- Extras Tab

- Troubleshooting Tab

- Printer Tab

- Using a Favorite Setting

- Using Help

Printing a Document

NOTES: 
• Your printer driver Properties window that appears in this User 

Guide may differ depending on the printer in use. However the 
composition of the printer properties window is similar.

• Check the Operating System(s) that are compatible with your 
printer. Please refer to the OS Compatibility section of Printer 
Specifications in your Printer User Guide.

• If you need to know the exact name of your printer, you can check 
the supplied CD-ROM.

The following procedure describes the general steps required for printing 
from various Windows applications. The exact steps for printing a 
document may vary depending on the application program you are 
using. Refer to the User Guide of your software application for the exact 
printing procedure.

1 Open the document you want to print.

2 Select Print from the File menu. The Print window is displayed. 
It may look slightly different depending on your application. 
The basic print settings are selected within the Print window. 
These settings include the number of copies and print range.

3 Select your printer driver from the Name drop-down list.
To take advantage of the printer features provided by your 
printer driver, click Properties or Preferences in the 
application’s Print window. For details, see “Printer Settings” on 
page 14.
If you see Setup, Printer, or Options in your Print window, click 
it instead. Then click Properties on the next screen.
Click OK to close the printer properties window.

4 To start the print job, click OK or Print in the Print window.

Make sure that your 
printer is selected.
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Printing to a file (PRN) 
You will sometimes need to save the print data as a file for your purpose. 

To create a file:

1 Check the Print to file box at the Print window.

2 Select the folder and assign a name of the file and then click 
OK.

Printer Settings
You can use the printer properties window, which allows you to access 
all of the printer options you need when using your printer. When the 
printer properties are displayed, you can review and change the settings 
needed for your print job. 

Your printer properties window may differ, depending on your operating 
system. This Software User Guide shows the Properties window for 
Windows XP.

Your printer driver Properties window that appears in this User Guide 
may differ depending on the printer in use.

If you access printer properties through the Printers folder, you can view 
additional Windows-based tabs (refer to your Windows User Guide) and 
the Printer tab (see “Printer Tab” on page 18).

NOTES:
• Most Windows applications will override settings you specify in 

the printer driver. Change all print settings available in the 
software application first, and change any remaining settings 
using the printer driver. 

• The settings you change remain in effect only while you are using 
the current program. To make your changes permanent, make 
them in the Printers folder. 

• The following procedure is for Windows XP. For other Windows 
OS, refer to the corresponding Windows User's Guide or online 
help.
1. Click the Windows Start button.
2. Select Printers and Faxes.
3. Select your printer driver icon.
4. Right-click on the printer driver icon and select 

Printing Preferences.
5. Change the settings on each tab, click OK.
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Layout Tab
The Layout tab provides options to adjust how the document appears 
on the printed page. The Layout Options includes Multiple Pages 
per Side, Poster Printing and Booklet Printing. See “Printing a 
Document” on page 13 for more information on accessing printer 
properties. 

Paper Orientation
Paper Orientation allows you to select the direction in which 
information is printed on a page. 
• Portrait prints across the width of the page, letter style. 
• Landscape prints across the length of the page, spreadsheet 

style. 
• Rotate allows you to rotate the page the selected degrees.

Layout Options
Layout Options allows you to select advanced printing options. You 
can choose Multiple Pages per Side and Poster Printing.
• For details, see “Printing Multiple Pages on One Sheet of Paper 

(N-Up Printing)” on page 19.
• For details, see “Printing Posters” on page 20
• For details, see “Printing Booklets” on page 20

Double-sided Printing
Double-sided Printing allows you to print on both sides of paper. 
• For details, see “Printing on Both Sides of Paper” on page 21.

 Landscape Portrait

Paper Tab
Use the following options to set the basic paper handling specifications 
when you access the printer properties. See “Printing a Document” on 
page 13 for more information on accessing printer properties. 

Click the Paper tab to access various paper properties. 

Copies
Copies allows you to choose the number of copies to be printed. 
You can select 1 to 999 copies. 

Size
Size allows you to set the size of paper you loaded in the tray. 
If the required size is not listed in the Size box, click Custom. When 
the Custom Paper Setting window appears, set the paper size and 
click OK. The setting appears in the list so that you can select it. 

Source
Make sure that Source is set to the corresponding paper tray.
Use Manual Feeder when printing on special materials like 
envelopes and transparencies. You have to load one sheet at a time 
into the Manual Feeder.
If the paper source is set to Auto Selection, the printer 
automatically picks up print material in the following tray order: 
Manual Feeder, Tray 1.

Type
Set Type to correspond to the paper loaded in the tray from which 
you want to print. This will let you get the best quality printout. If not, 
print quality may not be acheived as you want.
Cotton: 20 lb to 24 lb (75~90 g/m2) cotton paper such as Gilbert 
25% and Gilbert 100%. 
Plain: Normal plain paper. Select this type if your printer is 
monochrome and printing on the 16 lb (60 g/m2) cotton paper. 
Recycled: 20 lb to 24 lb (75~90 g/m2) recycled paper.
Color: 20 lb to 24 lb (75~90 g/m2) color-backgrounded paper.
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Archive: If you need to keep print-out for a long period time such as 
archives, select this option.

NOTE: For optimal performance and reliability consider using xerox 
paper.

First Page 
This property allows you to print the first page using a different 
paper type from the rest of the document. You can select the paper 
source for the first page. 
For example, load thick stock for the first page into the Manual 
Feeder, and plain paper into Tray 1. Then, select Tray1 in the 
Source option and Manual Feeder in the First Page option.

Scaling Printing
Scaling Printing allows you to automatically or manually scale your 
print job on a page. You can choose from None, Reduce/Enlarge, 
and Fit to Page. 
• For details, see “Printing a Reduced or Enlarged Document” on 

page 21.
• For details, see “Fitting Your Document to a Selected Paper Size” 

on page 21.

Graphics Tab
Use the following Graphic options to adjust the print quality for your 
specific printing needs. See “Printing a Document” on page 13 for more 
information on accessing printer properties. 

Click the Graphic tab to display the properties shown below. 

Resolution
The Resolution options you can select may vary depending on 
your printer model. The higher the setting, the sharper the clarity of 
printed characters and graphics. The higher setting also may 
increase the time it takes to print a document. 

Image Mode
The available options are Normal and Text Enhance. Some printers 
do not support this feature. 
• Printer Setting: If you select this option, this feature is 

determined by the setting you’ve made on the control panel of the 
printer. 

• Normal: This setting is for normal documents.
• Text Enhancement: Image Mode allows the user to enhance 

printouts. 

Toner Save Mode
Selecting this option extends the life of your print cartridge and 
reduces your cost per page without a significant reduction in print 
quality. Some printers do not support this feature. 
• Printer Setting: If you select this option, this feature is 

determined by the setting you’ve made on the control panel of the 
printer. 

• On: Select this option to allow the printer to use less toner on 
each page.

• Off: If you don’t need to save toner when printing a document, 
select this option.
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Advanced Options

You can set advanced settings by clicking the Advanced Options 
button. 
• Print All Text To Black: When the Print All Text To Black option 

is checked, all text in your document prints solid black, regardless 
of the color it appears on the screen. 

• Print All Text To Darken: When the Print All Text To Darken 
option is checked, all text in your document is allowed to print 
darker than on a normal document. Some printers do not support 
this feature. 

Extras Tab
You can select output options for your document. See “Printing a 
Document” on page 13 for more information about accessing the printer 
properties.

Click the Extras tab to access the following feature: 

Watermark
You can create a background text image to be printed on each page 
of your document. For details, see “Using Watermarks” on page 22.

Overlay
Overlays are often used to take the place of preprinted forms and 
letterhead paper. For details, see “Using Overlays” on page 23.

Output Options
• Print Subset: You can set the sequence in which the pages print. 

Select the print order from the drop-down list.
- Normal (1,2,3): Your printer prints all pages from the first page to 

the last page.
- Reverse All Pages (3,2,1): Your printer prints all pages from the 

last page to the first page.
- Print Odd Pages: Your printer prints only the odd numbered 

pages of the document.
- Print Even Pages: Your printer prints only the even numbered 

pages of the document.
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Troubleshooting Tab
Use the Troubleshooting tab for printer information page. See 
“Printing a Document” on page 13 for more information about accessing 
printer properties. 

Click the Troubleshooting tab to display the properties shown below. 

Printer Information Pages
To print information pages or to perform diagnostic actions, select 
an item from the list below and click Print.

Web Links
If you have an Internet connection and a browser installed, click one 
of the web links to connect to a web page directly from the driver.

About
Use the About tab to display the copyright notice and the version 
number of the driver.

Printer Tab
If you access printer properties through the Printers folder, you can view 
the Printer tab. You can set the printer configuration.

The following procedure is for Windows XP. For other Windows OS, refer 
to the corresponding Windows User's Guide or online help.

1 Click the Windows Start menu. 

2 Select Printers and Faxes.

3 Select your printer driver icon. 

4 Right-click on the printer driver icon and select Properties.

5 Click the Printer tab and set the options. 

Using a Favorite Setting
The Favorites option, which is visible on each properties tab, allows you 
to save the current properties settings for future use. 

To save a Favorites item:

1 Change the settings as needed on each tab. 

2 Enter a name for the item in the Favorites input box. 

3 Click Save. 
When you save Favorites, all current driver settings are saved.

To use a saved setting, select the item from the Favorites drop down 
list. The printer is now set to print according to the Favorites setting you 
selected. 

To delete a Favorites item, select it from the list and click Delete. 

You can also restore the printer driver’s default settings by selecting 
Printer Default from the list. 

Using Help
Your printer has a help screen that can be activated by clicking the Help 
button in the printer properties window. These help screens give detailed 
information about the printer features provided by the printer driver.

You can also click  from the upper right corner of the window, and 
then click on any setting. 
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4 Advanced Printing
This chapter explains printing options and advanced printing tasks. 

NOTE: 
• Your printer driver Properties window that appears in this User 

Guide may differ depending on the printer in use. However the 
composition of the printer properties window is similar.

• If you need to know the exact name of your printer, you can check 
the supplied CD-ROM.

This chapter includes:

• Printing Multiple Pages on One Sheet of Paper (N-Up 
Printing)

• Printing Posters

• Printing Booklets

• Printing on Both Sides of Paper

• Printing a Reduced or Enlarged Document

• Fitting Your Document to a Selected Paper Size

• Using Watermarks

• Using Overlays

Printing Multiple Pages on One Sheet 
of Paper (N-Up Printing) 
You can select the number of pages to print on a single sheet of paper. 
To print more than one page per sheet, the pages will be reduced in size 
and arranged in the order you specify. You can print up to 16 pages on 
one sheet. 

1 To change the print settings from your software application, 
access printer properties. See “Printing a Document” on 
page 13.

2 From the Layout tab, choose Multiple Pages per Side in the 
Layout Type drop-down list. 

3 Select the number of pages you want to print per sheet 
(1, 2, 4, 6, 9, or 16) in the Pages per Side drop-down list.

4 Select the page order from the Page Order drop-down list, if 
necessary. 
Check Print Page Border to print a border around each page 
on the sheet. 

5 Click the Paper tab, select the paper source, size, and type.

6 Click OK and print the document. 

1 2

3 4
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Printing Posters
This feature allows you to print a single-page document onto 4, 9, or 16 
sheets of paper, for the purpose of pasting the sheets together to form 
one poster-size document.

NOTE: The poster printing option is available when 600 dpi is 
selected in the resolution option on the Graphic tab.

1 To change the print settings from your software application, 
access printer properties. See “Printing a Document” on 
page 13.

2 Click the Layout tab, select Poster Printing in the Layout 
Type drop-down list.

3 Configure the poster option:
You can select the page layout from Poster<2x2>, 
Poster<3x3>, Poster<4x4> or Custom. If you select 
Poster<2x2>, the output will be automatically stretched to 
cover 4 physical pages. If the option is set to Custom, you can 
enlarge the original from 150% to 400%. Depending on the level 
of the enlargement, the page layout is automatically adjusted to 
Poster<2x2>, Poster<3x3>, Poster<4x4>. 

You can select the page layout from Poster<2x2>, 
Poster<3x3> or Poster<4x4>. If you select Poster<2x2>, the 
output will be automatically stretched to cover 4 physical pages. 
Specify an overlap in millimeters or inches to make it easier to 
pasting the sheets together. 

4 Click the Paper tab, select the paper source, size, and type.

5 Click OK and print the document. You can complete the poster 
by pasting the sheets together. 

0.15 inches

0.15 inches

Printing Booklets

This printer feature allows you to print your document on both sides of 
the paper and arranges the pages so that the paper can be folded in half 
after printing to produce a booklet. 

1 To change the print settings from your software application, 
access the printer properties. See “Printing a Document” on 
page 13.

2 From the Layout tab, choose Booklet Printing from the 
Layout Type drop-down list. 

NOTE: The Booklet Printing option is not available for all paper 
sizes. In order to find out the available paper size for this feature, 
select the paper size in the Size option on the Paper tab, then check 
if the Booklet Printing in a Layout Type drop-down list on the 
Layout tab is activated.

3 Click the Paper tab, and select the paper source, size, and 
type.

4 Click OK and print the document.

5 After printing, fold and staple the pages. 

8 9
8 9
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Printing on Both Sides of Paper
You can print on both sides of a sheet of paper. Before printing, decide 
how you want your document oriented.

The options are:
• Printer Setting, if you select this option, this feature is 

determined by the setting you’ve made on the control panel.
• None
• Long Edge, which is the conventional layout used in book 

binding.
• Short Edge, which is the type often used with calendars.

• Reverse Duplex Printing, allows duplex printing N-1 or 1-N. 

NOTE: Do not print on both sides of labels, transparencies, 
envelopes, or thick paper. Paper jamming and damage to the printer 
may result. 

1 To change the print settings from your software application, 
access printer properties. “Printing a Document” on page 13.

2 From the Layout tab, select the paper orientation.

3 From the Double-sided Printing section, select the binding 
option you want.     

4 Click the Paper tab and select the paper source, size, and type.

5 Click OK and print the document.

 Long Edge▲  Short Edge▲

2 5
3

2

5
3

2 5
3

2

5
3

Printing a Reduced or Enlarged 
Document 
You can change the size of a page’s content to appear larger or smaller 
on the printed page. 

1 To change the print settings from your software application, 
access printer properties. See “Printing a Document” on 
page 13. 

2 From the Paper tab, select Reduce/Enlarge in the Printing 
Type drop-down list. 

3 Enter the scaling rate in the Percentage input box.
You can also click the  or  button.

4 Select the paper source, size, and type in Paper Options. 

5 Click OK and print the document. 

Fitting Your Document to a Selected 
Paper Size
This printer feature allows you to scale your print job to any selected 
paper size regardless of the digital document size. This can be useful 
when you want to check fine details on a small document. 

1 To change the print settings from your software application, 
access printer properties. See “Printing a Document” on 
page 13.

2 From the Paper tab, select Fit to Page in the Printing Type 
drop-down list. 

3 Select the correct size from the Output size drop-down list.

4 Select the paper source, size, and type in Paper Options.

5 Click OK and print the document.

A
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Using Watermarks
The Watermark option allows you to print text over an existing document. 
For example, you may want to have large gray letters reading “DRAFT” 
or “CONFIDENTIAL” printed diagonally across the first page or all pages 
of a document. 

There are several predefined watermarks that come with the printer, and 
they can be modified, or you can add new ones to the list. 

Using an Existing Watermark
1 To change the print settings from your software application, 

access printer properties. See “Printing a Document” on 
page 13. 

2 Click the Extras tab, and select the desired watermark from the 
Watermark drop-down list. You will see the selected watermark 
in the preview image. 

3 Click OK and start printing. 

NOTE: The preview image shows how the page will look when it is 
printed.

Creating a Watermark
1 To change the print settings from your software application, 

access printer properties. See “Printing a Document” on 
page 13. 

2 Click the Extras tab, and click the Edit button in the Watermark 
section. The Edit Watermark window appears. 

3 Enter a text message in the Watermark Message box. You can 
enter up to 40 characters. The message displays in the preview 
window.
When the First Page Only box is checked, the watermark 
prints on the first page only.

4 Select watermark options. 
You can select the font name, style, size, or grayscale level 
from the Font Attributes section and set the angle of the 
watermark from the Message Angle section. 

5 Click Add to add a new watermark to the list.   

6 When you have finished editing, click OK and start printing. 

To stop printing the watermark, select (No Watermark) from the 
Watermark drop-down list. 

Editing a Watermark
1 To change the print settings from your software application, 

access printer properties. See “Printing a Document” on 
page 13. 

2 Click the Extras tab and click the Edit button in the Watermark 
section. The Edit Watermark window appears.

3 Select the watermark you want to edit from the Current 
Watermarks list and change the watermark message and 
options. 

4 Click Update to save the changes.

5 Click OK until you exit the Print window. 

Deleting a Watermark
1 To change the print settings from your software application, 

access printer properties. See “Printing a Document” on 
page 13.

2 From the Extras tab, click the Edit button in the Watermark 
section. The Edit Watermark window appears. 

3 Select the watermark you want to delete from the Current 
Watermarks list and click Delete. 

4 Click OK until you exit the Print window.
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Using Overlays

What is an Overlay?
An overlay is text and/or images stored in the computer hard disk drive 
(HDD) as a special file format that can be printed on any document. 
Overlays are often used to take the place of preprinted forms and 
letterhead paper. Rather than using preprinted letterhead, you can 
create an overlay containing the exact same information that is currently 
on your letterhead. To print a letter with your company’s letterhead, you 
do not need to load preprinted letterhead paper in the printer. You need 
only tell the printer to print the letterhead overlay on your document.

Creating a New Page Overlay
To use a page overlay, you must create a new page overlay containing 
your logo or image.

1 Create or open a document containing text or an image for use 
in a new page overlay. Position the items exactly as you wish 
them to appear when printed as an overlay.

2 To save the document as an overlay, access printer properties. 
See “Printing a Document” on page 13.

3 Click the Extras tab, and click Edit button in the Overlay 
section. 

4 In the Edit Overlay window, click Create Overlay. 

5 In the Create Overlay window, type a name of up to eight 
characters in the File name box. Select the destination path, if 
necessary. (The default is C:\Formover).

6 Click Save. The name appears on the Overlay List box. 

7 Click OK or Yes to finish creating. 
The file is not printed. Instead it is stored on your computer hard 
disk drive. 

NOTE: The overlay document size must be the same as the 
documents you print with the overlay. Do not create an overlay with 
a watermark. 

WORLD BEST

Dear ABC

Regards

WORLD BEST

Using a Page Overlay
After an overlay has been created, it is ready to be printed with your 
document. To print an overlay with a document:

1 Create or open the document you want to print. 

2 To change the print settings from your software application, 
access printer properties. See “Printing a Document” on 
page 13. 

3 Click the Extras tab. 

4 Select the desired overlay from the Overlay drop-down list box. 

5 If the overlay file you want does not appear in the Overlay list, 
click Edit button and Load Overlay, and select the overlay file. 
If you have stored the overlay file you want to use in an external 
source, you can also load the file when you access the Load 
Overlay window. 
After you select the file, click Open. The file appears in the 
Overlay List box and is available for printing. Select the overlay 
from the Overlay List box. 

6 If necessary, click Confirm Page Overlay When Printing. If 
this box is checked, a message window appears each time you 
submit a document for printing, asking you to confirm your wish 
to print an overlay on your document. 
If this box is not checked and an overlay has been selected, the 
overlay automatically prints with your document. 

7 Click OK or Yes until printing begins. 
The selected overlay downloads with your print job and prints 
on your document. 

NOTE: The resolution of the overlay document must be the same as 
that of the document you will print with the overlay. 

Deleting a Page Overlay
You can delete page overlays that you no longer use. 

1 In the printer properties window, click the Extras tab. 

2 Click the Edit button in the Overlay section. 

3 Select the overlay you want to delete from the Overlay List 
box. 

4 Click Delete Overlay. 

5 When a confirming message window appears, click Yes.

6 Click OK until you exit the Print window.
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5 Using Windows PostScript 
Driver
If you want to use the PostScript driver provided with your system 
CD-ROM to print a document.
PPDs, in combination with the PostScript driver, access printer 
features and allow the computer to communicate with the printer. An 
installation program for the PPDs is provided on the supplied 
software CD-ROM. 

Printer Settings
You can use the printer properties window, which allows you to access 
all of the printer options you need when using your printer. When the 
printer properties are displayed, you can review and change the settings 
needed for your print job. 

Your printer properties window may differ, depending on your operating 
system. This Software User Guide shows the Properties window for 
Windows XP.

Your printer driver Properties window that appears in this User Guide 
may differ depending on the printer in use.

NOTES:
• Most Windows applications will override settings you specify in 

the printer driver. Change all print settings available in the 
software application first, and change any remaining settings 
using the printer driver. 

• The settings you change remain in effect only while you are using 
the current program. To make your changes permanent, make 
them in the Printers folder. 

• The following procedure is for Windows XP. For other Windows 
OS, refer to the corresponding Windows User's Guide or online 
help.
1. Click the Windows Start button.
2. Select Printers and Faxes.
3. Select your printer driver icon.
4. Right-click on the printer driver icon and select 

Printing Preferences.
5. Change the settings on each tab, click OK.

Advanced
You can use advanced settings by clicking the Advanced button. 

• Paper/Output this option allows you to select the size of the 
paper loaded in the tray.

• Graphic this option allows you to adjust the print quality for your 
specific printing needs.

• Document Options this options allow you to set the PostScript 
options or printer features.

Using Help
You can click  from the upper right corner of the window, and then 
click on any setting. 
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6 Sharing the Printer Locally
You can connect the printer directly to a selected computer, which is 
called “host computer,” on the network. 

The following procedure is for Windows XP. For other Windows OS, refer 
to the corresponding Windows User's Guide or online help.

NOTES: 
• Check the Operating System(s) that are compatible with your 

printer. Please refer to the OS Compatibility section of Printer 
Specifications in your Printer User Guide.

• If you need to know the exact name of your printer, you can check 
the supplied CD-ROM.

Setting Up a Host Computer
1 Start Windows. 

2 From the Start menu select Printers and Faxes. 

3 Double-click your printer driver icon. 

4 From the Printer menu, select Sharing. 

5 Check the Share this printer box.

6 Fill in the Shared Name field, and then click OK.

Setting Up a Client Computer 
1 Right-click the Windows Start button and select Explore.

2 Select My Network Places  and then right-click Search for 
Computers.

3 Fill in the IP address of host computer in Computer name field, 
and click Search. (In case host computer requires User name 
and Password, fill in User ID and password of host computer 
account.)

4 Double-click Printers and Faxes.

5 Right-click printer driver icon, select Connect.

6 Click Yes, if the installation confirm message appears.
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7 Using Utility Applications
If an error occurs while printing, the Status Monitor window appears, 
showing the error. 

NOTES:
• To use the this program, you need:

- To check for Operating System(s) that are compatible with your 
printer, refer to Printer Specifications in your Printer User 
Guide.

- Internet Explorer version 5.0 or higher for flash animation in 
HTML Help.

• If you need to know the exact name of your printer, you can check 
the supplied CD-ROM.

Using Printer Settings Utility
Using the Printer Settings Utility, you can configure and check print 
settings. 

1 From the Start menu, select Programs or All Programs  → 
Xerox Phaser 3250 → Printer Settings Utility.

2 Change the settings. 

3 To send the changes to the printer, click the Apply button.

Using Onscreen Help
For more information about Printer Settings Utility, click  . 

Opening the Troubleshooting Guide
Double click the Status Monitor icon on the Windows task bar.

Or, from the Start menu, select Programs or All Programs  → Xerox 
Phaser 3250 → Troubleshooting Guide.

Changing the Status Monitor Program 
Settings
Select the Status Monitor icon on the Windows task bar and right-click 
on the Status Monitor icon. Select Options.

The following window opens.

• Display when job is finished for network printer shows the 
Status Monitor balloon when your job is complete. 

• Display when error occurs during printing shows the Status 
Monitor balloon when an error occurs during printing.

• Schedule an automatic status checking every allows the 
computer to update the printer status regularly. Setting the value 
close to 1 second causes the computer to check the printer status 
more frequently, thereby allowing a faster response to any printer 
error.

Double click this icon.
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8 Using Your Printer in Linux 
You can use your machine in a Linux environment. 

This chapter includes:

• Getting Started

• Installing the MFP Driver

• Using the MFP Configurator

• Configuring Printer Properties

• Printing a Document

Getting Started
The supplied CD-ROM provides you with  MFP Driver package for using 
your machine with a Linux computer.

After the driver is installed on your Linux system, the driver package 
allows you to monitor a number of machine devices via fast ECP parallel 
ports and USB simultaneously. 

The MFP Driver package is supplied with a smart and flexible installation 
program. You don't need to search for additional components that might 
be necessary for the MFP Driver software: all required packages will be 
carried onto your system and installed automatically; this is possible on 
a wide set of the most popular Linux clones.

Installing the MFP Driver

Installing the MFP Driver
1 Make sure that you connect your machine to your computer. 

Turn both the computer and the machine on.

2 When the Administrator Login window appears, type in root in 
the Login field and enter the system password.

NOTE: You must log in as a super user (root) to install the printer 
software. If you are not a super user, ask your system administrator.

3 Insert the printer software CD-ROM. The CD-ROM will 
automatically run.

If the CD-ROM does not automatically run, click the  icon at 
the bottom of the desktop. When the Terminal screen appears, 
type in:
If the CD-ROM is secondary master and the location to mount is 
/mnt/cdrom,
[root@localhost root]#mount -t iso9660 /dev/hdc /mnt/cdrom
[root@localhost root]#cd /mnt/cdrom/Linux
[root@localhost root]#./install.sh 
If you still failed to run the CD-ROM, type the followings in 
sequence:
[root@localhost root]#umount/dev/hdc
[root@localhost root]#mount -t iso9660 /dev/hdc /mnt/cdrom

NOTE: The installation program runs automatically if you have an 
autorun software package installed and configured.

4 When the welcome screen appears, click Next.
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5 When the installation is complete, click Finish.

The installation program has added the MFP Configurator 
desktop icon and Xerox MFP group to the system menu for your 
convenience. If you have any difficulties, consult the onscreen 
help that is available through your system menu or can 
otherwise be called from the driver package windows 
applications, such as MFP Configurator.

NOTE: Installing the driver in the text mode:
• If you do not use the graphical interface or have failed the driver 

installation, you have to use the driver in the text mode.
• Follow the step 1 to 3, then type [root@localhost Linux]# ./

install.sh, than follow the instruction on the terminal screen. Then 
the installation completes.

• When you wan to uninstall the driver, follow the installation 
instruction above, but type [root@localhost Linux]# ./uninstall.sh 
on the terminal screen.

Uninstalling the MFP Driver
1 When the Administrator Login window appears, type in root in 

the Login field and enter the system password.

NOTE: You must log in as a super user (root) to uninstall the printer 
software. If you are not a super user, ask your system administrator.

2 Insert the printer software CD-ROM. The CD-ROM will 
automatically run.

If the CD-ROM does not automatically run, click the  icon at 
the bottom of the desktop. When the Terminal screen appears, 
type in:

If the CD-ROM is secondary master and the location to mount is 
/mnt/cdrom,

[root@localhost root]#mount -t iso9660 /dev/hdc /mnt/cdrom

[root@localhost root]#cd /mnt/cdrom/Linux

[root@localhost root]#./uninstall.sh 

NOTE: The installation program runs automatically if you have an 
autorun software package installed and configured.

3 Click Uninstall.

4 Click Next. 

5 Click Finish.
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Using the MFP Configurator
MFP Configurator is a tool primarily intended for configuring Printer.

After installing the MFP Driver, the MFP Configurator icon will 
automatically be created on your desktop.

Opening the MFP Configurator
1 Double-click MFP Configurator on the desktop.

You can also click the Startup Menu icon and select Xerox MFP 
and then MFP Configurator.

2 Press each button on the Modules pane to switch to the 
corresponding configuration window.

You can use the onscreen help by clicking Help.

3 After changing the configurations, click Exit to close the MFP 
Configurator. 

Printers Configuration button

Ports Configuration button

Printers Configuration
Printers configuration has the two tabs: Printers and Classes. 

Printers Tab

You can see the current system’s printer configuration by clicking on the 
printer icon button on the left side of the MFP Configurator window.

You can use the following printer control buttons:
• Refresh: renews the available printers list.
• Add Printer: allows you to add a new printer.
• Remove Printer: removes the selected printer.
• Set as Default: sets the current printer as a default printer.
• Stop/Start: stops/starts the printer.
• Test: allows you to print a test page to check if the machine is 

working properly.
• Properties: allows you to view and change the printer properties. 

For details, see page 30.

Shows all of the 
installed printer.

Switches to Printer 
configuration.

Shows the status, 
model name and URI of 
your printer.
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Classes Tab

The Classes tab shows a list of available printer classes.

• Refresh : Renews the classes list.
• Add Class... : Allows you to add a new printer class.
• Remove Class : Removes the selected printer class.

Ports Configuration
In this window, you can view the list of available ports, check the status 
of each port and release a port that is stalled in busy state when its owner 
is terminated for any reason.

• Refresh : Renews the available ports list.
• Release port : Releases the selected port.

Shows the status of the 
class and the number of 
printers in the class.

Shows all of the 
printer classes.

Switches to 
ports 
configuration.

Shows the port type, 
device connected to the 
port and status

Shows all of the 
available ports.

Configuring Printer Properties
Using the properties window provided by the Printers configuration, you 
can change the various properties for your machine as a printer.

1 Open the MFP Configurator.

If necessary, switch to Printers configuration.

2 Select your machine on the available printers list and click 
Properties.

3 The Printer Properties window opens.

The following five tabs display at the top of the window:
• General: allows you to change the printer name, location and 

description. The name entered in this tab displays on the 
printer list in Printers configuration.

• Connection: allows you to view or select another port. If you 
change the printer port from USB to parallel or vice versa 
while in use, you must re-configure the printer port in this tab.

• Driver: allows you to view or select another printer driver. By 
clicking Options, you can set the default device options.

• Jobs: shows the list of print jobs. Click Cancel job to cancel 
the selected job and select the Show completed jobs check 
box to see previous jobs on the job list.

• Classes: shows the class that your printer is in. Click Add to 
Class to add your printer to a specific class or click Remove 
from Class to remove the printer from the selected class.

4 Click OK to apply the changes and close the Printer Properties 
Window.
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Printing a Document

Printing from Applications
There are a lot of Linux applications that you are allowed to print from 
using Common UNIX Printing System (CUPS). You can print on your 
machine from any such application.

1 From the application you are using, select Print from the File 
menu.

2 Select Print directly using lpr.

3 In the Xerox LPR window, select the model name of your 
machine from the Printer list and click Properties.

4 Change the printer and print job properties.

The following four tabs display at the top of the window.
• General - allows you to change the paper size, the paper 

type, and the orientation of the documents, enables the 
duplex feature, adds start and end banners, and changes the 
number of pages per sheet.

• Text - allows you to specify the page margins and set the text 
options, such as spacing or columns.

Click.

• Graphics - allows you to set image options that are used 
when printing images/files, such as color options, image size, 
or image position.

• Device: allows you to set the print resolution, paper source, 
and destination.

5 Click Apply to apply the changes and close the Properties 
window. 

6 Click OK in the Xerox LPR window to start printing.

7 The Printing window appears, allowing you to monitor the status 
of your print job.

To abort the current job, click Cancel.

Printing Files
You can print many different types of files on the Xerox machine device 
using the standard CUPS way - directly from the command line interface. 
The CUPS lpr utility allows you do that. But the drivers package replaces 
the standard lpr tool by a much more user-friendly Xerox LPR program.

To print any document file:

1 Type lpr <file_name> from the Linux shell command line and 
press Enter. The Xerox LPR window appears.

When you type only lpr and press Enter, the Select file(s) to 
print window appears first. Just select any files you want to print 
and click Open. 

2 In the Xerox LPR window, select your printer from the list, and 
change the printer and print job properties.

For details about the properties window, see page 31.

3 Click OK to start printing.
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9 Using Your Printer with a 
Macintosh
Your machine supports Macintosh systems with a built-in USB 
interface or a 10/100 Base-TX network interface card. When you 
print a file from a Macintosh computer, you can use the PostScript 
driver by installing the PPD file.

NOTE: Some printers do not support a network interface. Make 
sure that your printer supports a network interface by referring to 
Printer Specifications in your Printer User Guide.

This chapter includes:

• Installing Software

• Setting Up the Printer

• Printing

Installing Software
The PostScript driver CD-ROM that came with your machine provides 
you with the PPD file to use the PS driver, Apple LaserWriter driver, for 
printing on a Macintosh computer.

Printer driver

Installing the printer driver

1 Connect your machine to the computer using the USB cable or 
the Ethernet cable. 

2 Turn on your computer and the machine.

3 Insert the PostScript driver CD-ROM which came with your 
machine into the CD-ROM drive.

4 Double-click the P3250 on your Macintosh desktop. 

5 Double-click the MAC_Installer folder.

6 Double-click the MAC_Printer folder.

7 Double-click the Xerox Phaser 3250D or Xerox Phaser 
3250DN icon.

8 Click Continue.

9 Click Install.

10 After the installation is finished, click Quit.

Uninstalling the printer driver

1 Insert the CD-ROM which came with your printer into the CD-
ROM drive.

2 Double-click CD-ROM icon that appears on your Macintosh 
desktop.

3 Double-click the P3250 on your Macintosh desktop. 

4 Double-click the MAC_Installer folder.

5 Double-click the MAC_Printer folder.

6 Double-click the Xerox Phaser 3250D or Xerox Phaser 
3250DN icon.

7 Select Uninstall and then click Uninstall.

8 Click Continue.

9 When the uninstallation is done, click Quit.

Setting Up the Printer 
Set up for your printer will be different depending on which cable you use 
to connect the printer to your computer—the network cable or the USB 
cable.

For a Network-connected

NOTE: Some printers do not support a network interface. Before 
connecting your printer, make sure that your printer supports a 
network interface by referring to Printer Specifications in your 
Printer User Guide.

Mac OS 10.3 or higher (Xerox Phaser 3250D)

1 Follow the instructions on “Installing Software” on page 32 to 
install the PPD file on your computer.

2 Open the Applications folder → Utilities, and Print Setup 
Utility.
• For MAC OS 10.5, open System Preferences from the 

Applications folder, and click Printer & Fax.

3 Click Add on the Printer List.
• For MAC OS 10.5, press the “+” icon then a display window 

will pop up. 

4 For MAC OS 10.3, select the IP Printing tab. 
• For MAC OS 10.4, click IP Printer.
• For MAC OS 10.5, click IP.

5 Select Socket/HP Jet Direct in Printer Type.

WHEN PRINTING A DOCUMENT CONTAINING MANY 
PAGES, PRINTING PERFORMANCE MAY BE ENHANCED 
BY CHOOSING SOCKET FOR PRINTER TYPE OPTION. 
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6 Enter the printer’s IP address in the Printer Address field.

7 Enter the queue name in the Queue Name field. If you cannot 
determine the queue name for your printer server, try using the 
default queue first.

8 For MAC OS 10.3, if Auto Select does not work properly, select 
Xerox in Printer Model and your printer name in Model 
Name. 
• For MAC OS 10.4, if Auto Select does not work properly, 

select Xerox in Print Using and your printer name in 
Model. 

• For MAC OS 10.5, if Auto Select does not work properly, 
select Select a driver to use... and your printer name in 
Print Using. 

Your machine appears on the Printer List and is set as the 
default printer.

9 Click Add.

Mac OS 10.3 or higher (Xerox Phaser 3250DN)

1 Follow the instructions on “Installing Software” on page 32 to 
install the PPD file on your computer.

2 Open the Applications folder → Utilities, and Print Setup 
Utility.
• For MAC OS 10.5, open System Preferences from the 

Applications folder, and click Printer & Fax.

3 Click Add on the Printer List.
• For MAC OS 10.5, press the “+” icon then a display window 

will pop up. 

4 For MAC OS 10.3, select the Rendezvous tab. 
• For MAC OS 10.4, click Default Browser and find the 

Bonjour.
• For MAC OS 10.5, click Default and find the Bonjour.
The name of your machine appears on the list. Select 
XRX000xxxxxxxxx from the printer box, where the xxxxxxxxx 
varies depending on your machine.

5 For MAC OS 10.3, if Auto Select does not work properly, select 
Xerox in Printer Model and your printer name in Model 
Name. 
• For MAC OS 10.4, if Auto Select does not work properly, 

select Xerox in Print Using and your printer name in 
Model. 

• For MAC OS 10.5, if Auto Select does not work properly, 
select Select a driver to use... and your printer name in 
Print Using. 

Your machine appears on the Printer List and is set as the 
default printer.

6 Click Add.

For a USB-connected

Mac OS 10.3 or higher

1 Follow the instructions on “Installing Software” on page 32 to 
install the PPD file on your computer.

2 Open the Applications folder → Utilities, and Print Setup 
Utility.
• For MAC OS 10.5, open System Preferences from the 

Applications folder, and click Printer & Fax.

3 Click Add on the Printer List.
• For MAC OS 10.5, press the “+” icon then a display window 

will pop up. 

4 For MAC OS 10.3, select the USB tab. 
• For MAC OS 10.4, click Default Browser and find the USB 

connection.
• For MAC OS 10.5, click Default and find the USB connection.

5 Select your printer name.

6 For MAC OS 10.3, if Auto Select does not work properly, select 
Xerox in Printer Model and your printer name in Model 
Name. 
• For MAC OS 10.4, if Auto Select does not work properly, 

select Xerox in Print Using and your printer name in 
Model. 

• For MAC OS 10.5, if Auto Select does not work properly, 
select Select a driver to use... and your printer name in 
Print Using. 

Your machine appears on the Printer List and is set as the 
default printer.

7 Click Add.
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Printing 

NOTES: 
• The Macintosh printer’s properties window that appears in this 

User Guide may differ depending on the printer in use. However 
the composition of the printer properties window is similar.

• You can check your printer name in the supplied CD-ROM.

Printing a Document
When you print with a Macintosh, you need to check the printer software 
setting in each application you use. Follow these steps to print from a 
Macintosh.

1 Open a Macintosh application and select the file you want to 
print.

2 Open the File menu and click Page Setup (Document Setup 
in some applications). 

3 Choose your paper size, orientation, scaling, and other options 
and click OK.

4 Open the File menu and click Print.

5 Choose the number of copies you want and indicate which 
pages you want to print. 

6 Click Print when you finish setting the options.

Make sure that your 
printer is selected.

▲ Mac OS 10.3

Changing Printer Settings
You can use advanced printing features when using your printer.

From your Macintosh application, select Print from the File menu. The 
printer name which appears in the printer properties window may differ 
depending on the printer in use. Except for the name, the composition of 
the printer properties window is similar.

NOTE: The setting options may differ depending on printers and 
Macintosh OS version.

Layout

The Layout tab provides options to adjust how the document appears 
on the printed page. You can print multiple pages on one sheet of paper. 
Select Layout from the Presets drop-down list to access the following 
features.

• Pages per Sheet: This feature determines how many pages 
printed on one page. For details, see "Printing Multiple Pages 
on One Sheet of Paper" on the next column.

• Layout Direction: You can select the printing direction on a 
page as like the examples on UI.

▲ Mac OS 10.4
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Printer Features

This tab provides options for selecting the paper type and adjusting print 
quality. Select Printer Features from the Presets' drop-down list to 
access the following features:

• Reverse Duplex Printing: Allows you to select general print 
order compare to duplex print order. 

• Fit to Page (Phaser 3250DN only): This setting allows you to 
scale your print job to any selected paper size regardless of 
the digital document size. This can be useful when you want 
to check fine details on a small document.

• Image Mode: Image Mode allows the user to enhance 
printouts. The available options are Normal and Text 
Enhance. 

• Paper Type: Set Paper Type to correspond to the paper 
loaded in the tray from which you want to print. This will let 
you get the best quality printout. If you load a different type of 
print material, select the corresponding paper type.

• Resolution: You can select the printing resolution. The 
higher the setting, the sharper the clarity of printed characters 
and graphics. The higher setting also may increase the time it 
takes to print a document.

NOTE: For optimal performance and reliability consider using xerox 
paper.

▲ Mac OS 10.4

Printing Multiple Pages on One Sheet of 
Paper
You can print more than one page on a single sheet of paper. This 
feature provides a cost-effective way to print draft pages.

1 From your Macintosh application, select Print from the File 
menu. 

2 Select Layout.

3 Select the number of pages you want to print on one sheet of 
paper on the Pages per Sheet drop-down list.

4 Select the page order from the Layout Direction option.
To print a border around each page on the sheet, select the 
option you want from the Border drop-down list.

5 Click Print, and the printer prints the selected number of pages 
on one side of each page.

▲ Mac OS 10.4
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Duplex Printing
You can print on both sides of the paper. Before printing in the duplex 
mode, decide on which edge you will be binding your finished document. 
The binding options are:

Long-edged binding: Which is the conventional layout used in book 
binding.

Short-edged binding: Which is the type often used with calendars. 

1 From your Macintosh application, select Print from the File 
menu. 

2 Select the Layout. 

3 Select a binding orientation from Two-Sided option.

4 Click Print and the printer prints on both sides of the paper. 

CAUTION: If you have selected duplex printing and then try to 
print multiple copies of a document, the printer may not print 
the document in the way you want. In case of  "Collated 
copy", if your document has odd pages, the last page of the 
first copy and the first page of the next copy will be printed on 
the front and back of one sheet. In case of  "Uncollated 
copy", the same page will be printed on the front and back of 
one sheet. Therefore, if you need multiple copies of a 
document and you want those copies on both sides of the 
paper, you must print them one at a time, as separate print 
jobs.

▲ Mac OS 10.4
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